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About This Guide

The Synopsys Sentaurus™ Interconnect tool is an advanced 1D, 2D, and 3D simulator suitable
for IC interconnect reliability analysis. It features modern software architecture and
state-of-the-art models to address current and future interconnect technologies, and is capable
of mechanical, thermal, and electrical analysis.

Sentaurus Interconnect simulates process simulation steps, etching, and deposition along with
mechanical, thermal, and electrical analyses in 1D, 2D, and 3D. Three-dimensional capabilities
include meshing of boundary files using the MGOALS module, and an interface to Sentaurus
Structure Editor, which is the 3D geometry editing tool based on the ACIS solid modeling
library.

Sentaurus Interconnect uses the Alagator scripting language that allows users to implement and
solve their own nonmechanics partial differential equations. Alagator can be used to solve
various electrical and thermal analysis equations. Three-dimensional simulations are handled
in exactly the same way as for one dimension and two dimensions. Therefore, all of the
advanced models and user programmability available in one dimension and two dimensions
can be used in three dimensions.

Related Publications

For additional information, see:

» The TCAD Sentaurus release notes, available on the Synopsys SolvNet® support site (see
Accessing SolvNet on page Xx).

= Documentation available on SolvNet at https://solvnet.synopsys.com/DocsOnWeb.

Conventions

The following conventions are used in Synopsys documentation.

Convention Description

Blue text Identifies a cross-reference (only on the screen).

Bold text Identifies a selectable icon, button, menu, or tab. It also indicates the name of a field or an
option.

Courier font Identifies text that is displayed on the screen or that the user must type. It identifies the names
of files, directories, paths, parameters, keywords, and variables.
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Convention Description

Italicized text Used for emphasis, the titles of books and journals, and non-English words. It also identifies
components of an equation or a formula, a placeholder, or an identifier.

Menu > Command | Indicates a menu command, for example, File > New (from the File menu, select New).

Customer Support

Customer support is available through the Synopsys SolvNet customer support website and by
contacting the Synopsys support center.

Accessing SolvNet

The SolvNet support site includes an electronic knowledge base of technical articles and
answers to frequently asked questions about Synopsys tools. The site also gives you access to
a wide range of Synopsys online services, which include downloading software, viewing
documentation, and entering a call to the Support Center.

To access the SolvNet site:

1. Go to the web page at https://solvnet.synopsys.com.

2. If prompted, enter your user name and password. (If you do not have a Synopsys user name

and password, follow the instructions to register.)

If you need help using the site, click Help on the menu bar.

Contacting Synopsys Support

If you have problems, questions, or suggestions, you can contact Synopsys support in the
following ways:

= Go to the Synopsys Global Support Centers site on synopsys.com. There you can find
e-mail addresses and telephone numbers for Synopsys support centers throughout the
world.

= Go to either the Synopsys SolvNet site or the Synopsys Global Support Centers site and
open a case online (Synopsys user name and password required).
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Contacting Your Local TCAD Support Team Directly

Send an e-mail message to:

support-tcad-us @synopsys.com from within North America and South America.
support-tcad-eu@synopsys.com from within Europe.

support-tcad-ap@synopsys.com from within Asia Pacific (China, Taiwan, Singapore,
Malaysia, India, Australia).

support-tcad-kr@synopsys.com from Korea.

support-tcad-jp @synopsys.com from Japan.
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ciaerern 1 Getti ng Started

This chapter provides an overview of the functionality of Sentaurus
Interconnect and describes how to start the tool.

The TCAD Sentaurus Tutorial provides a range of projects to assist users to work with the tool.
To access the tutorial, go to:

$STROOT/tcad/SSTRELEASE/Sentaurus_Training/index.html

where STROOT is an environment variable that indicates where the Synopsys TCAD
distribution has been installed, and STRELEASE indicates the Synopsys TCAD release number.

Overview

Sentaurus Interconnect is a complete and highly flexible, multidimensional, IC interconnect
reliability analysis environment. With its modern software architecture and extensive breadth
of capabilities, Sentaurus Interconnect is a state-of-the-art simulation tool. It offers unique
predictive capabilities for modern silicon and nonsilicon technologies such as analyzing the
reliability of semiconductor interconnect structures. In particular, Sentaurus Interconnect
identifies hot spots in interconnect structures that are susceptible to void formation,
de-bonding, and cracking due to physical phenomena such as stress and temperature
excursions. These reliability concerns arise from both the manufacturing process and circuit
operation.

Sentaurus Interconnect accepts as input a sequence of commands that is either entered from
standard input (that is, at the command prompt) or composed in a command file. Simulations
are performed by issuing a sequence of commands that corresponds to the individual process
steps or analysis modes. In addition, several commands allow you to select physical models
and parameters, grid strategies, and graphical output preferences, if required. You should place
parameter settings in a separate file, which is sourced at the beginning of command files using
the source command.

In addition, the Alagator scripting language allows you to describe and implement your own
models, and thermal and electrical analysis equations.

Sentaurus™ Interconnect User Guide
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Setting Up the Environment

The STROOT environment variable is the TCAD Sentaurus root directory, and you must set this
variable to the installation directory of TCAD Sentaurus. The STRELEASE environment
variable can be used to specify the release of the software to run, for example, N-2017.09. If
STRELEASE is not set, the default version is used which is usually the last version installed.

To set the environment variables:

1. Set the TCAD Sentaurus root directory environment variable STROOT to the TCAD
Sentaurus installation directory, for example:

* Add to .cshrc
setenv STROOT <Sentaurus directory>
* Add to .profile, .kshrc, or .bashrc
STROOT=<Sentaurus directorys>; export STROOT
2. Addthe <Sentaurus directorys>/bin directory to the user path.
For example:
* Add to .cshrc:
set path=(<Sentaurus directory>/bin $path)
* Add to .profile, .kshrc, or .bashrc:

PATH=<Sentaurus directory>/bin:S$PATH
export PATH

Starting Sentaurus Interconnect

You can run Sentaurus Interconnect in either interactive mode or batch mode. In interactive
mode, a whole process flow can be simulated by entering commands line-by-line as standard
input. To start Sentaurus Interconnect in interactive mode, enter the following on the command
line:

> sinterconnect
Sentaurus Interconnect displays version and host information, followed by the Sentaurus

Interconnect command prompt. You now can enter Sentaurus Interconnect commands at the
prompt:

sinterconnect>

2 Sentaurus™ Interconnect User Guide
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This is a flexible way of working with Sentaurus Interconnect to test individual process steps
or short sequences, but it is inconvenient for long process flows. It is more useful to compile
the command sequence in a command file, which can be run in batch mode or inside Sentaurus
Workbench.

To run Sentaurus Interconnect in batch mode, load a command file when starting Sentaurus
Interconnect, for example:

> sinterconnect input.cmd

Starting Different Versions of Sentaurus Interconnect

To list all available releases in the TCAD Sentaurus installation directory, enter:

> sinterconnect -releases

To list all versions in a particular release directory, enter:

> sinterconnect -versions
You can select a specific release and version number of Sentaurus Interconnect using the -rel
and -ver options as follows:

> sinterconnect -rel <rel number> -ver <version numbers>

For example:

> sinterconnect -rel M-2016.12
The following command starts the simulation of nmos sis.cmd using version 1.2 of release
M-2016.12 as long as this version is installed:

> sinterconnect -rel M-2016.12 -ver 1.2 nmos_sis.cmd

Using a Command File

Instead of entering Sentaurus Interconnect commands line-by-line, the required sequence of
commands can be saved to a command file, which can be written entirely by users. To save time
and reduce syntax errors, you can copy and edit examples of command files available from the
TCAD Sentaurus Tutorial or in this user guide.

If a command file has been prepared, run Sentaurus Interconnect by typing the following
command:

sinterconnect <command filenames

Sentaurus™ Interconnect User Guide 3
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Alternatively, you can automatically start Sentaurus Interconnect through the Scheduler in
Sentaurus Workbench. The command file has the extension .cmd. (This is the convention used
in Sentaurus Workbench.)

The command file is checked for correct syntax and then commands are executed in sequence
until the simulation is stopped by the command exit or the end of the file is reached. Since
Sentaurus Interconnect is written as an extension of the tool command language (Tcl), all Tcl
commands and functionalities (such as loops, control structures, creating and evaluating
variables) are available in command files. This results in some limitations in syntax control if
the command file contains complicated Tcl commands. You can switch off syntax-checking
with the command-line option -n, for example:

sinterconnect -n commandfile

Sentaurus Interconnect ignores character strings starting with a hash (#) character (although
Sentaurus Workbench interprets # as a special character for conditional statements). Therefore,
this special character can be used to insert comments in the simulation command file.

A file with the extension .1og is created automatically whenever Sentaurus Interconnect is run
from a command line, that is, outside the Sentaurus Workbench environment. This file contains
the runtime output, which is generated by Sentaurus Interconnect and is sent to standard output.
When Sentaurus Interconnect is run using a command file <root filename> sis.cmd, the
output file is named <root filename> sis.log.

When Sentaurus Interconnect is run from Sentaurus Workbench, the output file is named
<root_filename>_ sis.out.

For a complete list of commands, see Appendix A on page 361.
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This chapter provides an overview of how Sentaurus Interconnect
operates.

The syntax and features of the command file are described, followed by an overview of the
parameter database, which contains all of the model parameters, and technical details regarding

the running of the tool.

For new users, see Interactive Mode on page 12, Syntax for Creating Command Files on
page 16, and Creating and Loading Structures and Data on page 33. For advanced users who

need to adjust model parameters, see Parameter Database on page 21.

Overview

To familiarize users with the different formatting used in this documentation, input commands

from either a command file or the command line are presented this way:

sinterconnect -v

An example of output is:

LR RS SRR SRR RS RS EE R RS R R R EEEEREEE R R SRR EERREE R R R R EEEEEEEEEEEEEEEEEEEEEES

* k% Sentaurus Interconnect

*kk Version N-2017.09

*ok ok (1.7, RHEL64)

* k%

*kk Copyright (C) 1993-2002

*kk The board of regents of the University of Florida
* ok Copyright (C) 1994-2017

* kK Synopsys, Inc.

* % %
*x* This software and the associated documentation are confidential

*** and proprietary to Synopsys, Inc. Your use or disclosure of this
***% goftware is subject to the terms and conditions of a written

***% license agreement between you, or your company, and Synopsys, Inc.

* ok k

* %k %k

*kk

*kk

*kk

* ok k

* %k k

*kk

* ok k

* Kk

* ok k

*kk

* Kk

LRSS SRR SRR SRS SRR RS R R R R EEEEREEERREEEEREERREEEREEREEEEEEEEREEEEEEEEEEEEE]

Compiled Fri Jul 14 23:54:02 PDT 2017 on tcadprod8

Started at: Tue Jul 11 10:25:16 2017 (CEST)
User name: jbrowne

Sentaurus™ Interconnect User Guide
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Host name: topo2
PID: 25333
Architecture: x86 64
Operating system: Linux rel. 2.6.18-274.12.1.el5 ver. #1 SMP Tue Nov 8 21:37:35
EST 2011

Interactive Visualization

The options for interactive visualization in Sentaurus Interconnect are:

= An X-Windows-based graphical display (which will be phased out in future releases)

This viewer can be used for 1D and 2D simulations, and is launched with either the
plot.1d or plot.2d command (see plot.1d on page 546 and plot.2d on page 549).

= An interface to Sentaurus Visual (which will eventually replace the X-Windows display)

Interface to Sentaurus Visual

The interface to Sentaurus Visual can visualize 1D, 2D, and 3D structures and data evolution
while the simulation progresses (see Figure 1 on page 7). The interface is initiated and
controlled from Sentaurus Visual, including control of the simulation.

Table 1 Buttons of the Simulation Control panel of Sentaurus Visual

Button Description

] Load: Load a command file.

v When a command file is loaded, it is thereafter referred to as the flow.

’ Run: Run the flow.
Use this button either to start running the flow or to continue execution after pausing the flow. The
simulation continues at the location of the cursor (line with a light-yellow background).

II Pause: Pause the running flow.
The pause occurs either when the currently executing step (command) is finished or, for a long-
running step, when the current time step is completed.

. Reset: Reset the running flow.
The running flow stops, the connection to the simulator is terminated, and you return to the start of
the flow.

I’ Run Step: Run the next step in the flow.
When you click this button, either a single step (command) is executed or a group of commands
enclosed in braces is executed. You must repeatedly click this button to execute the next steps.
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Table 1

2: Working With the Simu
Interactive Visualiz

Buttons of the Simulation Control panel of Sentaurus Visual

Button

Description

s

Save: Save the flow.

=

Save As: Save the flow under a new name.

In addition, the graphics command can be used to control the plot settings in Sentaurus
Visual and to select which fields are visible (see graphics on page 428).
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Figure 1 Interface to Sentaurus Visual: upper pane of Simulation Control panel shows
command file and lower pane of Simulation Control panel shows log file
Sentaurus™ Interconnect User Guide

N-2017.09




2: Working With the Simulator
Interactive Visualization

Setting Up the Interface

To set up and to run the interface:
1. Launch Sentaurus Visual with the following command-line options:
> svisual -spi &
2. In Sentaurus Visual, choose Edit > Preferences.
3. In the User Preferences dialog box, expand the categories to Common > Miscellaneous.
4. In the Simulator group box:

a) In the Command field, type the tool binary as well as any command-line option
required, for example:

sinterconnect -n
b) In the Communication Option field, type --svi.

5. Click Save.

Loading Command Files

To load a command file:

1. In the Simulation Control panel, click the Load button (see Figure 1 on page 7).
The Load File dialog box is displayed.

2. Select the command file to open.

3. Click Open.

In addition, a command file can be loaded from the command line using:

svisual -spi <filename>

Inserting Breakpoints in the Flow

To set breakpoints to pause the simulation at a particular step in the flow:

1. Click in the left margin, at the line corresponding to the step (command) where you want
the flow to stop.

A red circle marks the breakpoint (see Figure 2 on page 9).

2. Click the Run button to execute the entire flow or the Run Step button to execute individual
steps.

8 Sentaurus™ Interconnect User Guide
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NOTE You can set multiple breakpoints in a flow.

Deleting Breakpoints in the Flow

To delete a breakpoint:

»  Click the red circle in the left margin.

(o) (>) (] (a][» @l

| fremoteftcad2l/skylinepl0fsroflinuxfopt/sinterconnect/Test/electrical/current/dual_damasc 3d/dual damasc 3d/dual damasc 3d.sis ‘

1l » # Testcase: SI Current Apalysis, fixed potential biases

2
3 # Define regional contacts

4 contact region=contactl name=ctl
5 contact region=contact2 name=ct2
6
7
8
9

# Bias the contacts
supply contact.name=ctl voltage=1.0e-4<V=
supply contact.name=ct2 voltage=0<V>

1LE # Grid settings

12 pdbSet Grid No3DMerge 1 ;# Test continous BC's between same material interfaces
13 refinebox clear

14 refinebox interface materials = {Copper Metal Oxide} min.normal.size = 0.02

Breakpoint normal.growth.ratio = 1.2
Insertion ® 1nit bnd=dual_damasc_3d
17
18 mode current
19

20  # Start simulation

21 solve info=2

f 22

Breakpoint 3  d#struct tdr=res new !Gas

? 2
Insertion ~~——fpg S{ruct tdr-res TGas
25

26 set max_E_field [select name=ElectricField max]

27 set max_curr_dens [select name=ConductionCurrentDensity max]
28 LogFile "MAX(E-field) = $max E field V/cm"

29 LogFile "MAX(curr_dens) = $max_curr_dens A/cm™2"

30 set cl [contact Potential name= "ctl" current]

il set c2 [contact Potential name= "ct2" current]

32 LogFile "$cl\t$c2”

33

Figure 2  Setting a breakpoint in the flow (red circle indicates location of breakpoint)

Indicating Status of Steps

In the Simulation Control panel, as the flow is being executed, a green triangle in the left
margin (in the same location as breakpoints) indicates the step that will be executed next. A red
triangle indicates the step that is currently being executed.

Already executed steps are indicated with a gray background. This part of the flow cannot be
changed further.

Sentaurus™ Interconnect User Guide 9
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In addition, wherever the cursor is in the flow, its position is indicated by highlighting the line
with a light yellow background.

Updating the Structure

In 3D simulations, two plots are shown with the titles ‘bulk’ and ‘boundary’ (see Figure 1 on
page 7). This is because, in 3D simulations, both the bulk and boundary are not always up to
date. The plot with its title in bold shows the last updated information. For example, if the
insert command is called in a 3D simulation, the boundary is updated; however, by default,
the mesh is not updated. After the insertion operation is completed, the title of the ‘boundary’
plot will be bold, and the title of the ‘bulk’ plot will not be bold.

Controlling the Interface to Sentaurus Visual With the
graphics Command

To quickly visualize the evolution of a structure or data, the use of the graphics command is
not necessary. Simply launch the interface to Sentaurus Visual and adjust the plot settings in
Sentaurus Visual.

However, when setting up a flow for the first time or for calibration-type activities, the same
command file might need to be run and rerun many times. In these cases, it is convenient to use
the graphics command to specify the Sentaurus Visual plot settings directly into the
command file to avoid having to repeatedly change the plot settings in Sentaurus Visual for
each run.

Another case where the graphics command is needed is choosing the availability or selection
of nonstandard fields for visualization.

In general, graphics commands are executed in the usual sequential order as specified in the
command file; whereas, settings specified in Sentaurus Visual will be executed immediately.
In either case, the latest command to be executed will determine the current settings.

Unless otherwise specified, the arguments of the graphics command are independent and can
be used in any combination (see graphics on page 428).
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Command-Line Options

Table 2 lists the command-line options that are available in Sentaurus Interconnect.

Table 2 Command-line options
Option Short name of option Function
(if available)

--batchMode -b Switches off graphics.

--diff Diff mode. To see differences in data and Sentaurus
Interconnect parameter settings between two TDR files.
Interpolation is used to compare results from different
meshes. Usage:
sinterconnect --diff <filel> <file2>
where <filel>and <file2> are TDR files.

--FastMode -f Generates structure, no partial differential equation
(PDE) solve, and so on.

--GENESISeMode -u Switches off log file creation.

--home <directorys>

-0 <directorys>

Sets STHOME to <directorys.

--noSyntaxCheck

Switches off syntax check.

--pdb

Runs the Parameter Database (PDB) Browser showing
parameters as they are set during runtime. Includes
default parameters and parameters from the command file
if specified.

--ponly

Same as - -pdb, but only shows parameters set in the
command file; does not show default parameters.

--quickSyntaxCheck

Only checks syntax of branches that are true.

--svi

Switches on the Sentaurus Visual interface mode. This
option is usually specified in the User Preferences dialog
box of Sentaurus Visual (see Setting Up the Interface on
page 8).

--syntaxCheckOnly

Only checks syntax, no execution.

--xml

Switches on the creation of an XML-style marked-up log
file for use in the TCAD Logfile Browser
(see Utilities User Guide, Chapter 2 on page 5).

Prints header with version number.

Prints use and command-line options.

Sentaurus™ Interconnect User Guide
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Table 2 Command-line options

Option Short name of option Function
(if available)
-X Tests floating-point exception handling.
-X Switches off floating-point exception catching.

Interactive Mode

Sentaurus Interconnect runs in interactive mode if no command file is given. In this mode,
commands can be entered (at the command prompt) line-by-line and are executed immediately.

It is useful to run Sentaurus Interconnect in the interactive mode for the following reasons:

= When debugging Tcl code, the program does not quit if a Tcl error is found. The error is
displayed and you are prompted again for input. You can source a command file repeatedly
if required.

» To easily obtain PDB parameter names and defaults with the pdbGet command.

» To print the list of built-in functions with the help command, and to print the list of Tcl
procedures with the info procs command.

» To obtain command parameter names and defaults for any built-in command by using the
params flag available in all built-in functions.

Another use of the interactive mode is to pause the simulation using the fbreak command.
When the simulation is paused in interactive mode, the state of the simulator can be queried
using a number of commands including grid, mater, and select. Pausing the simulation can
also be useful when using interactive graphics as described in Interactive Visualization on
page 6.

Fast Mode

When working on a new process flow, it is useful to run Sentaurus Interconnect a few times
using the fast mode (-f command-line option). Developing a new process flow can be
complex, involving many etch, deposit, and photo steps, some with masks; sometimes
adjustments are required. In the fast mode, all 3D remeshing and all electrical, thermal, and
solve commands are ignored. Only process commands for structure generation and analysis are
performed. In this mode, when in three dimensions, all struct commands will write only a
boundary into a TDR file, since the simulation mesh is not synchronized with the modified
structure.

12 Sentaurus™ Interconnect User Guide
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Terminating Execution

You can terminate a running Sentaurus Interconnect job in several ways. In some cases, the
termination will take time or will fail for other reasons. The most fail-safe method is to use the
UNIX command:

kill -9 <process_id>

where <process 1id> is the process ID number of the running Sentaurus Interconnect job
which can be obtained with the UNIX ps command. This sends a signal SIGKILL to the
corresponding Sentaurus Interconnect job, which will cause the job to terminate immediately.

If Sentaurus Interconnect is run directly from a UNIX shell, usually you can terminate the run
by using shortcut keys. The key sequence is interpreted by the shell command, which sends a
signal to the job in the foreground. Usually, Ctrl+C sends a SIGINT signal and Ctrl+\
(backslash) sends a SIGQUIT signal. The running Sentaurus Interconnect job catches all
SIGINT signals and waits for three signals to be caught (in case it was typed accidentally)
before terminating itself.

However, Sentaurus Interconnect does not catch the SIGQUIT signal, so this signal will
typically cause Sentaurus Interconnect to terminate immediately.

Because the exact behavior may depend on your UNIX shell, the operating system, and the
local configuration, refer to the manual for the UNIX shell you are running or contact your
local systems administrator for more information.

Environment Variables

The Sentaurus Interconnect binary relies on several supporting files found using the
environment variables STHOME and SCHOME. To change default models and parameters without
modifying the installed Sentaurus Interconnect files, copy the default STHOME and SCHOME
directories and set the environment variables (STHOME and SCHOME) to the location of the
modified directories.

By default, STHOME and SCHOME are set based on the Synopsys standard environment variables
STROOT and STRELEASE, and by the version number of Sentaurus Interconnect using:

SIHOME = $STROOT/tcad/$STRELEASE/lib/sinterconnect-<version numbers
SCHOME = S$STROOT/tcad/$STRELEASE/lib/score-<version numbers

Sentaurus™ Interconnect User Guide 13
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Inside the STHOME directory, there is the subdirectory Tc1Lib. Inside the SCHOME directory,
the two major subdirectories are Tc1Lib and Params:

» The subdirectory $SIHOME/TclLib contains all the default model selections in the file
SINTERCONNECT.models.

s The Tcl files are located in the subdirectories $SIHOME/TclLib and $SCHOME/TclLib.

» The subdirectory $SCHOME/Params contains the parameter database (see Parameter
Database on page 21).

File Types

The main file types used in Sentaurus Interconnect are:

s Command file (* . cmd)

This is the main input file for Sentaurus Interconnect. It contains all the process steps and
can be edited. It is referred to as the command file or input file.

= Logfile (*.1log and *.out)

Sentaurus Interconnect generates a .1og file when it is run from the UNIX command line
and an .out file when run from Sentaurus Workbench. Whichever file is written contains
information about each processing step, and the models and values of physical parameters
used in it. The amount of information written to the log file is controlled by the info
argument, which is available for nearly all commands (see Common Arguments on
page 363). The global default information level (0) can be changed with
pdbSet InfoDefault <ns>. Allowed values of InfoDefault are 0, 1, and 2 with
higher values indicating more verbose output. Any value higher than 2 will be interpreted
as 2.

There is a limit to the size of the log file. By default, it is 1.9 (~1 GB). The simulation
terminates if the limit is reached. This limit can be changed using the double-parameter
Log.File.Limit:

pdbSet Log.File.Limit <value>

In addition, you can set the simulation to continue without logging any more entries after
the limit is reached using:

pdbSet Continue.Past.Log.Limit 1
»  Marked-up log file (* . xm1)

When the --xml option is specified on the command line, Sentaurus Interconnect
generates a separate log file containing XML-like tags. This file contains exactly the same
information as the .1og file. The additional XML-like tags are used to format the .1og file
for efficient access to the information by displaying the structure of the log file content in
the TCAD Logfile Browser. Tags for common modules are written automatically. You can
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add custom section tags to mark important processing units with the Section,
SubSection.Start, and SubSection.End commands. Refer to the Utilities User
Guide for information about the TCAD Logfile Browser.

TDR boundary file (*_bnd.tdr)

This file stores the boundaries of the structure without the bulk mesh or fields. It can be
used as the structure file for the Sentaurus Mesh meshing engine and can be loaded into
Sentaurus Visual for viewing. The name of a TDR boundary file can be specified using the
tdr argument of the init command, and then the loaded boundary will be meshed.

TDR grid and doping file (*_sis.tdr)

TDR files can be used to split and restart a simulation. Such restart files are saved using the
struct tdr=<c> command because restarting requires interface data, parameter and
command settings, mesh ordering information as well as bulk grid and data. If either ! pdb
or !interfaces is specified in the struct command, the TDR file will not be suitable
for restarting. The TDR file can be loaded into Sentaurus Interconnect using the init
command, but the results of the subsequent simulation steps might differ in the simulation
with the split and restart compared to a simulation of the entire flow in one attempt. TDR
files store the following types of information:

* Geometry of the device and the grid.
* Distribution of doping and other datasets in the device.

* The internal structure of the mesh in Sentaurus Interconnect required to restore the
simulation mesh to the same state in memory that is present at the time of saving the
file. Restart files store coordinates and field values without scaling to prevent round-off
eITors.

* By default, Sentaurus Interconnect stores all changes to the parameter database made
after initial loading of the database and all commands that create objects later
referenced, such as refinement boxes and masks in the TDR file. A TDR file can be
either reloaded into Sentaurus Interconnect to continue the simulation or loaded into
Sentaurus Visual for visualization.

The parameter settings stored in a TDR file can be viewed using pdbBrowser
-nopdb -tdr <tdrfiles (see Viewing Parameters Stored in TDR Files on page 30).

For information about the TDR format, refer to the Sentaurus™ Data Explorer User
Guide.
XGRAPH file (*.plx)

This file is used to save 1D distributions of the doping concentration or other fields in a
specified 1D cross section. This file can be viewed by loading it into Inspect.
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Syntax for Creating Command Files

This section describes how to create command files manually. It is important to remember that
Sentaurus Interconnect is written as an extension of the tool command language (Tcl). This
means that the full capability and features of Tcl are available in the command files as well as
the interactive mode of Sentaurus Interconnect.

Standard Tcl syntax must be followed; for example, a hash symbol (#) at the beginning of a
line denotes a comment and the dollar sign ($) is used to obtain the value of a variable. Major
features of Tcl include for loops, while loops, if then else structures, switch statements,
file input and output, sourcing external files, and defining procedures (functions). Variables can
be numbers, strings, lists, or arrays. Refer to the literature for more information [1].

Before the command file is executed, its syntax is checked. This is accomplished by first
modifying the command file so that all branches of control structures such as if then else
and switch commands are executed. In addition, a special flag is set so that no structure
operations or operations that depend on the structure are performed. This allows the syntax
check to run quickly but thoroughly. Sometimes, the modifications made to the command file
during syntax checking interfere with the definition or redefinition of Tcl variables, generating
a false syntax error. In these cases, switch off syntax checking for the part of a command file
using the special CHECKOFF and CHECKON commands:

# Skip syntax check for part of command file
# The CHECKOFF/CHECKON commands must start at the beginning of the line
# and be the only command on the line
CHECKOFF
if { $mode }
array set arr $listl
} else {
set arr $list2 ;# error only if both branches are executed
}

CHECKON
# further commands are syntax checked

Tcl Input

Sentaurus Interconnect has been designed to optimize the use of Tcl. Some examples of this
interaction include:

» Command parameter values are evaluated with Tcl. For example, expr can appear in the
value of an expression, that is, parameter=[expr $pp/10.0] is valid Sentaurus
Interconnect syntax. This particular expression sets the parameter parameter to the value
of pp/10 if the Tcl variable pp was previously defined with the Tcl set command.
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Tcl expressions may appear in model parameter values in the parameter database. In some
cases, Sentaurus Interconnect parameters are set with Tcl commands to be a function of
other parameters.

Sentaurus Interconnect contains many callback procedures, which can be redefined by
users to provide flexibility.

Many modular built-in functions are available for postprocessing, which can be combined
into a Tcl script to create powerful analytic tools.

There are special Sentaurus Interconnect versions of set (£set) and proc (£proc), which
are stored in TDR files. When simulations are restarted using a TDR file, the settings given
by £set and fproc from the previous simulation will be available.

Other syntax rules to consider when writing command files are:

One command is entered on one line only. There are two exceptions to this rule:

* A backslash (V) is used to extend a command on to multiple lines if it appears as the last
character on the line.

» If there is an opening brace, Tcl will assume the command has not finished until the
line containing the matching closing brace.
Command parameters have the following form:

* Boolean parameters are true if the name appears on the line. They are false if they are
preceded by an exclamation mark (!).

* Parameters that are of type integer or floating point must appear as
parameter=value pairs.

* String parameters are enclosed, in general, in double quotation marks (" "), for
example, parameter="string".

» Lists can be enclosed in double quotation marks or braces, for example:

parameter= {iteml item2 ...}
parameter= "iteml item2 ..."

You must have a space between the equal sign and the opening brace.

NOTE It is important to separate the equal sign from the parameter value by a
space because Tcl delimiters such as ‘"’ and ‘{’ are ignored if they
appear in the middle of a string. Sentaurus Interconnect can handle no
space between an equal sign and a double quotation mark, but it cannot
correct the case where there is no space between an equal sign and an
opening brace.

* Some parameters take a list of keyword=value pairs, for example:

epi.doping= {Boron = 1le20 Arsenic = lel8}
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NOTE For convenience, all parameters that take a numeric value will have an
extra Tcl eval applied to them. This means that even if the value of a
parameter is enclosed in braces { }, the parameter will still be evaluated.
For example:

set vall 1.0
set val2 2.0
refinebox xrefine= {$vall $val2}

will be evaluated as:

refinebox xrefine= {1.0 2.0}

Specifying Materials

Materials are specified in the same way for all PDB commands that require a material
parameter. For a bulk material, specify only one material. For an interface material, specify two
materials combined with an underscore (_).
Some examples of specifying materials with PDB commands are:

pdbSet ... Oxide ... ;# Command applies to oxide.

pdbSet ... Oxide Silicon ... ;# Command applies to the Si-Si02 interface.

The order of materials for interfaces is lexical. However, some common material combinations
have aliases. For example, Silicon_ Oxide is an alias for Oxide Silicon.

Materials are specified in the same way for all other commands that require a material
parameter. For a bulk material, specify only one material. For an interface material, specify two
materials: one without a slash and one with a slash (/).
Some examples of specifying materials with other commands are:
<command> ... oxide ;# Command applies to oxide.
<command> ... silicon /oxide ;# Command applies to the Si-Si02 interface.
The complete list of materials available can be found in the file:
$STROOT/tcad/$STRELEASE/1ib/score-<version numbers>/TclLib/tcl/Mater.tcl

In that file, the lines that contain mater add create a material. For more information about
creating new materials, see mater on page 497.

NOTE Materials present in the Mater.tcl file do not necessarily have
parameters in the parameter database. Attention must be paid to
initializing parameters for a new material.
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Aliases

Sentaurus Interconnect allows more control over the names of command parameters, the
abbreviations of parameter names, as well as interface names. These aliases only apply to
parameters of built-in Sentaurus Interconnect commands, and the pdbSet and pdbGet family
of commands.

This permits clarity and uniformity to commonly used names. Another benefit is that it is easier
to maintain backward compatibility for parameter names while not restricting future parameter
names that could conflict with common abbreviations (that is, V could refer to either vacancy
or void).

An explicit list of allowed aliases is maintained in the $SCORE/TclLib directory (see
Environment Variables on page 13 for information about how the location of the TclLib
directory is determined). The alias command is used to view and extend the list of allowed
aliases (see alias on page 368).

To print the list of aliases:

sinterconnect> alias -list

To view the alias of a parameter name, for example, Vac:

sinterconnect> alias Vac
Vacancy

If an alias does not exist, the same parameter name is returned:

sinterconnect> alias NotAParam
NotAParam

To create a new alias for a parameter name, for example, the alias Vaca for the parameter
Vacancy:

sinterconnect> alias Vaca

Vaca

sinterconnect> alias Vaca Vacancy
sinterconnect> alias Vaca
Vacancy

For interface names, aliases for the sides can be used irrespective of the order. For example, if
Ox is an alias for Oxide and Si is an alias for Silicon, then Ox_Si or Si_Ox is automatically
an alias for the Oxide Silicon interface. This flexibility does not apply to side-specific
interface parameters. For example, TransferRate Si is not automatically an alias for
TransferRate Silicon.
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Default Simulator Settings: SINTERCONNECT.models File

Sentaurus Interconnect starts a simulation by reading the SINTERCONNECT . models file in the
$STHOME/TclLib directory. This file defines various default parameters and directories used
during the simulation such as:

= The path for Tcl library files

= Default material names

s The math parameters for 1D, 2D, and 3D simulations
= Default solution names

= Default callback procedures

The SINTERCONNECT .models file is read once at the beginning of the simulation. You can
override any of the default parameters after the file is read.

Compatibility With Previous Releases

Occasionally, the default parameter and model settings change in Sentaurus Interconnect to
ensure that the default behavior gives robust, accurate, and computationally efficient results on
current production technologies. Usually, when new models and algorithms are developed,
they are optional. After some experience is gained, the default can be changed to take
advantage of the new model or algorithm.

The old model and algorithm settings are collected into a file for each release and are available
so that you can recover results from previous releases. Each file contains only those parameter
changes that occurred for that particular release, so that if the release specified in the
Compatibility command is older than the most recent release, the most recent release
parameters are set first, followed by older releases in reverse chronological order (see
Compatibility on page 380).

For example, the command Compatibility K-2015.06 issued for Version N-2017.09 will
first apply parameters consistent with M-2016.12, then with parameters consistent with
L-2016.03, and finally parameters consistent with K-2015.06. Aliases are available for the
release name so you do not need to know the release foundation letter. For example, 2015.06
can be used instead of K-2015.06.

Files with the compatibility parameter settings are stored in $STROOT/tcad/$STRELEASE/
lib/sinterconnect/TclLib/Compatibility. These files provide a useful list of all
default parameter changes for each release.
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NOTE As a result of code corrections and numeric accuracy limitations, exact
reproduction of results from previous releases is not always possible.

NOTE If the Compatibility command is used, it must be the first command
in a command file so that all subsequent commands that depend on the
defaults take into account the compatibility setting.

For example, to apply the defaults of Version M-2016.12, the first line of the command file
must be:

Compatibility 2016.12

NOTE The Compatibility command does not change the default parameter
and algorithm settings for Sentaurus Mesh, Sentaurus Structure Editor,
and the MGOALS module. To change the backward compatibility
setting for MGOALS, see MGOALS Backward Compatibility on
page 271.

Parameter Database

The parameter database stores all Sentaurus Interconnect material and model parameters as
well as global information needed for save and reload capabilities. There is a hierarchical tree
directory inside the Params directory, which stores the default values. (To locate the Params
directory, see Environment Variables on page 13.)

Data is retrieved using the pdbGet command and is set using the pdbSet command. The
pdbGet and pdbSet commands are checked for correctness of syntax, and they print the
allowed parameter names if a mistake is made. These commands are used to obtain and set all
types of data stored in the parameter database: Boolean, string, double, double array, and
switch.

The higher-level pdbset and pdbGet commands call lower-level type-specific commands
(pdbGetBoolean, pdbGetDouble, pdbGetDoubleArray, pdbGetString,
pdbGetSwitch, pdbGetSwitchString, pdbSetBoolean, pdbSetDouble,
pdbSetDoubleArray, pdbSetString, and pdbSetSwitch) that are not checked for errors
and, therefore, are not recommended for typical use. These commands have a slight
performance advantage and are used internally.

You can set some parameters in a region-specific manner. Regions can be named with the
region and deposit commands and, if region-specific parameters exist, they will override
the material-specific parameters if any. However, there are many circumstances where this will
not give the desired behavior. In that case, you must create a new material that inherits its
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parameters from an existing material. Then, you must change the material properties of the new
material as needed (see Like Materials: Material Parameter Inheritance on page 23).

Inside the Params directory are subdirectories that define the highest level nodes in the
database. Inside each subdirectory is a file Info, which contains parameters of that level. In
addition, directories in the database have named files that contain parameters, which are under
the node defined by the file name. For example, in the Params database, there is a directory
called silicon, which contains a file Info. The parameters inside Info are located under the
Silicon node. As another example, the Potential file inside the Silicon directory is
another node. This node contains parameters that are related to the Potential under the
Silicon node.

Inside the files of the parameter database are commands that set the database parameters. The
commands have the form:

array set $Base { <NAME> { <TYPE> <VALUE> } }

where:
= <NAME> is the parameter name.
m <TYPE> is one of Boolean, String, Double, DoubleArray, or Switch.

= <VALUE> is a Tcl expression that sets the default value.

It is often necessary to enclose the <VALUE> expression in braces. Some Tcl procedures have
been created to increase the usefulness of <VALUE> expressions, such as the Arrhenius
function.

If you start Sentaurus Interconnect and call the pdbGet command of a parameter that contains
an Arrhenius function, it will return the temperature-dependent Arrhenius function of that
parameter. In Sentaurus Interconnect, temperature is a local variable and can be changed with
the SetTemp command. In addition, the solve command changes the local temperature for
each time step.

Other functions that appear in the pdb parameters are pdbGet* functions, which allow
parameters to be set as a function of other parameters.

For the DoubleArray type, a Tcl list is set that is ordered pairwise:
{keyl valuel key2 value2 ...} where the parameter setting for key1 is valuel.

Material parameters can be stored under the known region name. To set and obtain the
parameter value, use the region name instead of the material name. If the parameter is not found
under the region name, it is taken from the material of that region.

Sentaurus Interconnect writes directly to the parameter database in a number of ways. Mostly
this is performed to save information for reload capabilities using the TDR format. Data written
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by the program into the parameter database is not available within the default Params directory
or the Parameter Database Browser, but can be read using the pdbGet command.

For information about the TDR format, refer to the Sentaurus™ Data Explorer User Guide.

Like Materials: Material Parameter Inheritance

The parameters of a material can be inherited from the parameters of another material using
the special Like parameter in the PDB. When this is the case, the two materials are referred to
as like materials. This can be used to specify different settings in different regions. First, a new
material is created and made to be like an existing material using:

mater add name=<c> new.like=<c>

where:
= name specifies the name of the material to be created.

» new.like is the name of the existing material from which all default values are inherited.

NOTE It is important to use the mater command instead of directly creating
the Like parameter because the mater command will make all
interfaces to the new material like the appropriate interface to the
existing material.

Interpolation Between Like Materials

By default, data is interpolated between like materials, for example, when you insert a region
that overlaps an existing region of a like material. The inheritance direction does not matter;
either the inserted material is like the existing material, or the existing material is like the
inserted material.

To prevent interpolation between a material and other materials that are like it, use:

mater name=<c> add !like.interpolate

Interface Parameters

When using the Parameter Database commands and the Alagator language, interfaces are
specified as a pair of materials separated by an underscore (_), for example, Gas Oxide and
Oxide_ Silicon. The official name follows alphabetic order, and the first letter is capitalized.
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However, aliases are provided that allow their order to be reversed; some shorter names are
allowed; and all lowercase is generally available.

As an example of setting an interface parameter, the following command sets the numeric
tolerance Abs . Error at the gas—silicon interface to 1e3:

pdbSet Gas _Silicon Vac Abs.Error le3

Regionwise Parameters and Region Name-Handling

Many parameters in the parameter database can be specified regionwise including parameters
related to meshing and mechanics parameters. Those parameters used by Alagator as part of
equations and terms, however, cannot be specified regionwise: this includes all solution-related
parameters. For the rest of the parameters, internally, the program checks if there is a
regionwise specification of the parameter; if not, the materialwise specification is used.

The name of regions can be specified with the region command and deposit command;
however, the name:

= Must not contain an underscore (_) or a period (.) because these characters have special
meaning.

= Must be different than an existing material name.

During the course of the simulation, geometric operations such as etch and reflect can split
regions in two. If this happens, the history of the region is maintained through its name. For
example, if a region is originally named layer1 and it is etched into two pieces, they will be
named layerl.1l and layerl.2 according to rules given below.

These two regions will inherit the parameters of layerl. Furthermore, parameters for
layerl.1 and layerl.2 also can be specified separately. If a subsequent step such as a
deposit reunites layerl.l and layerl.2, the region will be given the name layerl.
Conversely, if 1layer1 .1 is split into two regions, the regions will be named layer1.1.1 and
layerl.1.2, and so on. In this way, regionwise parameter specification is preserved for the
life of the region or its parts.

The numbering of split regions is performed according to the spatial location of the pieces. The
lowest point of each piece to be renamed is found (in the coordinate system of Sentaurus
Interconnect, this would be the largest x-coordinate). To avoid numeric noise, the coordinates
are compared with a specified epsilon given by pdbGet Grid RenameDelta (hereafter,
referred to as RN). If the x-coordinates of the pieces to be renamed are not within RN of each
other, the regions are ordered from lowest to highest, that is, from the highest x-coordinate to
the lowest. If any piece has its lowest coordinate within RN, its y-coordinate is compared, that
is, from the lowest coordinate to the highest.
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layer1.1

deltax %

}

Figure 3 lllustration of region-naming rules

layer1.2

For example, in Figure 3, 1ayer1 is split into two regions and the quantity deltax is less than
RN, so the region on the left is given the name layerl .1 and the region on the right is given
the name layerl.2. If deltax had been greater than RN, the region on the right would have
been given the name layerl. 1 because it would have been considered lower than the region
on the left. Similarly, in three dimensions, first x and y are compared, and if they are both within
RN, z is used for ordering, that is, from the lowest coordinate to the highest.

You can apply the above operation to the whole structure with grid rename. In this case, all
the regions are renamed similarly to the above rules but, instead of the root being chosen by the
user, all regions of the same material have the root given by the names of the materials and the
extension is _<n> where <n> is the region number, for example Silicon 1,Silicon_2,and
so on. This should only be used as a postprocessing step because all region-specific parameters
no longer apply when the name of a region has changed.

Sentaurus Interconnect automatically unites regions with the same material type. For example,
if silicon is deposited on top of an existing silicon region, both regions are united, so there will
be only one silicon region. If regions must be united and region names do not follow the rules
mentioned in this section, the united region will take the name of one of the materials in the
united region.

Parameter Database Browser: Viewing the Defaults

The Parameter Database (PDB) Browser is a graphical representation of the parameter
database that allows you to view and edit parameters. The PDB Browser has three distinct areas
(see Figure 4 on page 26):

» Parameter hierarchy overview in a tree structure representation.

» Parameter information in a spreadsheet representation. The columns are Parameter, Type,
Value, Unit, Evaluate, Comment, Tool, and Info Level (hidden by default).
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The status bar has three indicators that show:

Graphic window to plot the parameter dependency on the temperature.

The temperature used in temperature-dependent functions such as Arrhenius.

]
» The temperature point set for the x-axis.
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Figure 4  Parameter Database Browser
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Starting the Parameter Database Browser

To start the PDB Browser from the command line, type:

pdbBrowser

This searches for the parameter database in the same location as Sentaurus Interconnect.
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You can set the environment variables STHOME and SCHOME to change the location of the
parameter database for the PDB Browser and Sentaurus Interconnect (see Environment
Variables on page 13).

You can select Tools > Filter to choose which parameters to display.

To view parameters in a command file merged with defaults, use:

sinterconnect --pdb <command file>

To view only the parameters specified as input in a command file, use:

sinterconnect --ponly <command file>

PDB Browser Functions

The following functions are available from the File and Tools menus:

File > Export Node

Saves the selected node into a specified file in tab-delimited format.

File > Export Tree
Saves the entire parameter database into a specified file in tab-delimited format. The fields
of the file are Parameter Name, Type, Value Evaluation, Original Value, and
Comments.

Tools > Evaluate
Evaluates the value of the selected parameter and displays the result in the Evaluate column
of the spreadsheet. Values can contain Tcl expressions.

Tools > Plot

(Applies only to parameters of type double and double array.) Plots the dependency of the
selected parameter on the temperature in logarithmic coordinates versus 1/T. The default
set of temperature values is {700.0 800.0 900.0 1000.0 1100.0}. The resulting
graphs are displayed in the graphic window; otherwise, an error message is displayed.

Tools > Plot Over

The same as Plot but it does not clear the graphic window of previous graphs.

NOTE You can zoom in by dragging the mouse. To zoom out, use the middle
mouse button, or click the Zoom Out and Zoom Off buttons.
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Tools > Arrhenius Fit

Using the Arrhenius Fit dialog box, you can find the best prefactor and energy for an
Arrhenius fit of a given profile, taken from the list of temperature—value pairs. The results
can be plotted in the graphic window:

—Pairtg ————— Input List
Temperature 700 a7
goo 4.8

Walue = | 400 23
Clear all |

—Results

|5?.334285934DD?96 0.223762945104335 -0.9399167631.

Flot | Flot COver | Cancel |

Tools > Find, Tools > Find Next

Matches the pattern entered against parameter names according to the options selected in
the Find dialog box. Patterns can include regular Tcl expressions. The match is highlighted
when found:

Find | Goto |

Find what: [*Late

Search Ih

1 Whole Word
W Match Case | ® Tree - Table

Ok | Cancel

Tools > Goto Line

Highlights a table row or tree node that corresponds to the number entered.

Tools > Filter

Selects which parameters to display.

Tools > Info Level

Chooses which parameters to display ranging from basic parameters to all parameters.

Viewing Parameter Information

Double-clicking a nonempty cell in the spreadsheet allows you to view the corresponding
parameter information in a separate window. To close the window, click the Close button.
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NOTE To display a shortcut menu, right-click a parameter and select
commands for editing, evaluating, or plotting.

PDB Browser Preferences

The PDB Browser allows you to reset the default settings for the following values using the
Preferences menu, the shortcut keys, or the shortcut menu of the graphic window:
Preferences > Editor > Change Editor

Resets the default editor.

Preferences > Editor > Reset Update Time

Resets the update interval.

Preferences > Graph > Set Temperature

Sets the global temperature used in the temperature-dependent functions. Default: 1000.0.

Preferences > Graph > Reset X Points

Displays the Reset Temperature Points dialog box where you set the x-axis temperature
points. The default setis {700.0 800.0 900.0 1000.0 1100.0}:

’—Temperature A Points: 700.0 800 900 ...

F00.0 §00.0 900.0 1000.0 1100.0 j

ok | cancal |

Preferences > Graph > Data Point Symbol

Sets the symbol to use for data points.

Preferences > Graph > X Scale

Resets the x-scale to logarithmic or linear.

Preferences > Graph > Y Scale

Resets the y-scale to logarithmic or linear.

Preferences > Tree Node

Hides the node tip or shows the node tip.

Sentaurus™ Interconnect User Guide 29
N-2017.09



2: Working With the Simulator
Parameter Database Browser: Viewing the Defaults

Preferences > Info Level

Shows or hides the Info Level column of the spreadsheet.

Preferences > Font > Family

Changes the font family.

Preferences > Font > Size

Changes the font size.

Preferences > Cursor

Changes the style of the cursor.

Viewing Parameters Stored in TDR Files

Parameters stored in TDR files can be viewed using the pdbBrowser command run from the
command line instead of through Sentaurus Interconnect. By default, the PDB Browser reads
parameters from the Sentaurus Interconnect database directory (which can be changed with the
SIHOME and SCHOME environment variables). In addition, parameters stored in a TDR file can
be read in using the -tdr <filename> option of the PDB Browser. Parameters that appear
in the parameter database are overwritten by those contained in the TDR file, so the resultant
parameter set will be the same as if Sentaurus Interconnect had read in the file. On the other
hand, it is also useful to know which parameters are only in the TDR file. To read only those
parameters, the database reading can be switched off using the -nopdb command-line option.

For example, the following command reads the PDB Browser and then reads the parameters
from the n10_sis.tdr file, overwriting values contained in the parameter database:

> pdbBrowser -tdr nl0 sis.tdr

For example, the following command reads only the parameters in the n10 sis.tdr file:

> pdbBrowser -nopdb -tdr nl0 sis.tdr
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Understanding Coordinate Systems

Sentaurus Interconnect and related tools use different coordinate systems.

Wafer Coordinate System

The wafer coordinate system is fixed with respect to the wafer flat or notch, and is used to
define the relationship of all other coordinate systems to the physical wafer.

The wafer x- and y-axes form a naturally oriented coordinate system when the wafer is drawn
with the flat pointing down as shown in Figure 5. This coordinate system is used for layout
information, such as mask locations, and for setting a cutline using the Cut Line2D command.

Zy Yw

XW
Figure 5  Wafer coordinate system

Simulation Coordinate System

The simulation coordinate system is used to define the mesh for the simulation. The default
coordinate system is the unified coordinate system (UCS).

The visualization coordinate system is the UCS as well.
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In the UCS, the x-axis points into the wafer and the y-axis is rotated with respect to the wafer
y-axis. Figure 6 shows the UCS. Simulations in one dimension use only the x-axis. Simulations
in two dimensions use only the x- and y-axes.

slice.angle Yw

A Ys

Ys Zs

slice.angle

\

Xs Xy

Figure 6  Unified coordinate system (slice.angle= 45)

The rotation of the simulation axes with respect to the wafer axes is given by the slice.angle
parameter of the init command. The slice angle is measured from the wafer y-axis to the
simulation y-axis with positive angles counterclockwise about the wafer z-axis.

The default value of slice.angle is —90°. This causes the simulation y-axis to match the
wafer x-axis, which is the usual cut direction through the layout for 2D simulations (see
Figure 7).

Zy Y

slice.angle

Y

slice.angle

Y \ \/

Xg z

Figure 7  Unified coordinate system when using default value of slice.angle (—90°)

NOTE For backward compatibility, the DF-ISE coordinate system is still
available, but it is not recommended.
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Creating and Loading Structures and Data

The first step in most simulations is either to load an existing structure or to create a new one.
New structures are created through a combination of the 1ine, region, and init commands.
The initial mesh is a tensor-product mesh where the density of lines is specified using the 1ine
command, and the regions are defined by specifying tags in the 1ine commands and defined
in the region command. The initial regions are always defined as axis-aligned rectangles in
two dimensions and axis-aligned bricks in three dimensions.

Defining the Structure: The line and region Commands

The line and region commands are used together to define the structure. In the init
command, the structure is actually formed. Care must be taken when creating a structure
because there are few checks for errors.

These rules must be followed to obtain a valid structure:

» Ifthis is not the first structure being created in a command file, the command line clear
must be issued to remove 1ine commands and stored mesh ticks.

» Line locations must be given in increasing order.

» The region boundaries are defined by tagged lines. Tagged lines are created with the 1ine
command where the parameter tag has been set (as well as the 1ocation parameter).

= Atleast one region command must be given to define the substrate.

= Regions must have a material specification, except for the substrate case described
below.

= Regions must have the same dimensionality as the 1ine commands used (that is, if
line yis given, a 2D region is expected with y1lo and yhi set in the region command).

» The spacing parameter of the 1ine command is used to create lines between user-defined
lines, so that not every line must be specified in the command file. Sentaurus Interconnect
smoothly grades the line density between user-defined lines to match as closely as possible
the spacing at each user-defined line. In addition, there will be lines at locations given by
the location parameter of the 1ine command. By default, the spacing parameter is
extremely large, so that if it is not set, only lines given by the 1ocat ion parameter will be
in the mesh.

s The *1o parameter refers to the lowest coordinate value, that is, the location of the line
corresponding to the x1o tag must be less than the coordinate corresponding to the xh1i tag.

» The region command can be used to tag a region as a substrate in two ways:

» If the region is being defined with the material name and the parameters *hi and *1lo,
the Boolean keyword substrate will tag this region as the substrate.
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* If the structure is being loaded from a previously saved file, the command:
region name=<c> substrate

will tag the region with <c> as the name of the substrate. This is the only occasion when
the region command will be called after the init command.

Considerations when creating structures are:

= For 2D and 3D simulations, it is advantageous to create a coarse mesh in the lateral (that
is, y- or z-directions) because lines created with the 1ine command run all the way through
the structure. Often, finer spacing in the y- or z-direction is required near the surface;
whereas, further in the bulk, a coarser spacing is required (to minimize the size of the
problem).

=  When MGOALS is used for etching and deposition, it automatically creates a local
refinement near interfaces that does not run the length of the structure.

» To specify refinement boxes, use the refinebox command.

Creating the Structure and Initializing Data

The init command is used to create the structure. If the 1ine and region commands have
been given to create a structure from the beginning, the init command does not require any
options. It will take the structure definition and create a new structure.

Many process steps such as etching and deposition require a gas mesh. By default, Sentaurus
Interconnect does not add a gas mesh during the init command, but delays creating the gas
mesh until it is needed. To add the gas mesh immediately, use the command:

pdbSet Grid AddGasMesh 1

NOTE The parameter must be set before the init command to generate the
gas mesh during the init command.

There are different ways to initialize fields at the time the initial structure is created from 1ine
and region commands:

» Toinitialize data everywhere in the structure, a field specification can be given in the init
command.

» To initialize data in one particular region only, a field specification is given in the region
command.

In both the init and region commands, the £ield parameter specifies the name of the data
field that will be created, and the concentration parameter is used to specify the value
created. The init command must not be used to initialize stress values (use instead either the
stressdata command or the select command).
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The init command also can read a structure from a file, for example:

init tdr= file ;# Read geometry, data, and PDB parameters from file.tdr

The TDR format is the default format and can store all the information necessary to restart a
simulation when using ‘splits’ in Sentaurus Workbench. This format stores all pdb parameter
settings as well as numerous other settings coming from commands (see Saving a Structure for
Restarting Simulations on page 39).

The init command specifies the principal wafer orientation (wafer.orient) and the lateral
crystal orientation of the wafer flat or notch (notch.direction).

Defining the Crystal Orientation

Generally, the orientation of a hexagonal crystal system can be described using four Miller
indices <ijtks>; whereas, only three Miller indices <ijk> are needed for other systems. In a
hexagonal crystal system, the sum of the first three indices equals zero (i+j+t = 0);
therefore, the third index t is redundant and can be omitted. For simplicity and consistency, the
wafer orientation and the flat orientation are specified using three Miller indices for all lattice
systems including hexagonal.

The crystal orientation of the wafer is established by specifying the Miller indices of the wafer
surface and the wafer flat. The wafer.orient and notch.direction (originally
flat.orient) arguments of the init command specify the Miller indices of the wafer z-axis
and negative y-axis, respectively. The wafer surface orientation (whose surface normal is
chosen as the wafer z-axis) is set using wafer.orient= {<i> <j> <k>} where <i>, <j>,
and <k> are the crystallographic (Miller) indices of the plane. The notch direction or the flat
orientation (a direction that coincides with the wafer negative y-axis) can be set arbitrarily, but
it must be orthogonal to the surface normal of the wafer orientation.

The default surface orientation is 100 and the default flat orientation is a 110 direction for all
lattice systems.

NOTE The wafer.orient and notch.direction arguments of the init
command apply to any crystalline systems in the structure. However,
these settings are superseded by the material-specific wafer orientation
(vertical.orient) and flat orientation (horizontal.orient) as
specified in the mater command.
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Table 3 lists the crystallographic directions of the wafer axes for the most common
crystallographic orientations of the wafer as shown in Figure 5 on page 31.

Table 3 Miller indices of wafer axes for each value of wafer.orient
(wafer axes are defined in Figure 5)
Wafer orientation Xw Yw Zy
100 [110] [110] [001]
110 [001] [110] [110]

111

[112]

[110]

[111]

To facilitate simulations of hybrid orientation technology, Sentaurus Interconnect predefines
three materials (Silicon, Siliconl110, and Silicon111) for crystalline silicon. These
materials have exactly the same properties, except for the default crystal orientations that are
<100>, <110>, and <111> for Silicon, Siliconl110, and Siliconl11, respectively.

Automatic Dimension Control

The maximum dimension of a simulation is determined by the specified 1ine commands:

» line x commands define the extensions in the vertical direction and are required for 1D,
2D, and 3D simulations.

» If, inaddition, 1ine ycommands are specified, the maximum dimension of the simulation
will be at least two dimensions.

» If, inaddition, 1ine zcommands are specified, the maximum dimension of the simulation
will be three dimensions.

By default, Sentaurus Interconnect delays the creation of a full-dimensional structure until it
becomes necessary. This means that if you specify a 2D structure where all regions span the
entire simulation domain in the y-direction, Sentaurus Interconnect will create a 1D structure.

When a 2D or 3D mask is used in an etch, a deposit, or a photo command, Sentaurus
Interconnect automatically extrudes the structure and the mesh into the appropriate dimension
and copies the data. This delay of creating a full-dimensional structure can be switched off in
the init command using the option !DelayFullD. To increase the dimension manually, use
the grid command. If a 2D structure is required, that is, both the 1ine x and line y
commands but no 1ine z commands have been specified, grid 2D or grid FullD will
cause a 2D structure to be created.

Similarly, if 1ine x, line vy, and 1ine =z commands have been specified, grid 2D can be
used to extrude a 1D structure to two dimensions, and a 1D or 2D structure is extruded to three
dimensions using grid 3D or grid FullD. This functionality also can be used to increase
the dimension of structures loaded from files. After the structure has been loaded, 1ine
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commands can be issued and the dimension of the structure will increase automatically when
necessary or manually using the grid command.

Sentaurus Interconnect does not provide a facility to reduce the dimension of a simulation.

When structures are saved to TDR files (other than TDR restart files), the current maximum
dimension as specified with 1ine commands is used by default in the file. The dimension of
the simulation itself is not affected. To save files in the current dimension, the ! FullD
parameter of the struct command can be used (see Saving Structures on page 38). TDR
restart files are always saved in the dimension currently used in the simulation.

Interpolating Field Data From an External Structure File
Using the load Command

The 1oad command can be used to interpolate data from a TDR file onto the current structure
(see load on page 487). For 1D structures, 1D TDR files are allowed. For 3D structures, 3D
TDR files are allowed. However, for 2D structures, either a 2D TDR file or a 3D TDR file is
allowed.

When loading a 3D file to a 2D structure, the data on the 2D overlap cross-section, between the
3D structure and the 2D structure, is interpolated to the current 2D mesh. The 2D structure is
assumed to be located at z=0.

Several options can handle the new and old datasets. For example, the merge option loads only
datasets that do not currently exist in the structure, the sum option adds new datasets and sums
the matching datasets, the replace option adds new datasets and replaces existing datasets
with new datasets of the same name, and the rename option adds new datasets and renames
them by adding the suffix _ 1oad. These actions also can be applied individually to selected
datasets using the species and actions arguments.

For example, the following command sums Potential Saved and the existing
Potential Saved (if available), and replaces the existing Temperature data field by the
one in the TDR file:

load tdr= in species= {Potential Saved Temperature} actions= {sum replace}
The external structure also can be translated or rotated before interpolation with the
transform argument. This is especially useful when loading 3D data to a 2D structure since

the cross section must be at z=0 (the 2D structure is assumed to be allocated at z=0). For
example, the following command loads the 3D data at z=0.5 instead of z=0:

load tdr= source3d transform= { 1 0001000 10. 0. -0.5}
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While the following command loads the 3D data at y=0 since the 3D structure was rotated, and
the y-axis and the z-axis were exchanged:

load tdr= source3d transform= { 1 00001010 0. 0. 0. }

To ensure the transformation is performed correctly, you may save a TDR file for the
transformed structure with the save . transform argument.

Loading 1D Profiles: The profile Command

The profile command can load a 1D profile into 1D, 2D, or 3D structures (see profile on
page 583). The file to be read must contain one x-coordinate data pair per line. Both linear and
logarithmic interpolation are available. For example, profiles are loaded using:

profile infile= file.dat name= Boron

In this case, Sentaurus Interconnect reads the file.dat file and sets the Boron field
accordingly.

Saving Structures

Sentaurus Interconnect uses the TDR file format for saving the structure geometry with and
without the bulk mesh and data, and with contacts. TDR files contain simply connected regions
to operate smoothly with other Synopsys TCAD tools. One important option available for
saving files is to omit saving gas regions because this may cause problems for other tools.

The TDR format allows you to save and load geometry and data information along with pdb
parameters (see File Types on page 14).

TDR files can be used to split a simulation, and to restart and continue the simulation as if no
file save or file load was performed. Besides the simulation grid and data, additional
information is stored to facilitate such a restart.

NOTE It is recommended to set the simulation coordinate system using the
math coord.ucs command, which specifies the use of the unified
coordinate system (UCS). When using the UCS, the visualization
coordinates are identical to the simulation coordinates.

To select the fields stored in TDR files, use the Set TDRList command. Each field name in the
SetTDRList command is added to the list of fields, which are usually saved (if the field is
present in the structure). This command also takes a macro parameter Solutions.
Solutions refers to variables of partial differential equations (PDEs). The solution variables
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must be stored in a TDR file if that file is to be used to continue a simulation. By default, TDR
files are saved with Solutions names in Set TDRList. However, this requires many fields to
be stored in the TDR files and, sometimes, it is more convenient to have fewer fields.

To do this, set ! Solutions in Set TDRList, which deselects all fields. Then, specify the field
names to be stored in the TDR file.

Saving a Structure for Restarting Simulations

When saving files using the TDR format, the current state of the parameter database is, by
default, saved in the file. The parameter database contains all of the information necessary to
restart a simulation including:

»  Model settings

= Parameter settings

» Geometric tolerance settings

= Refinement boxes from the refinebox command
» Temperature ramps from the temp ramp command
= Line specifications from the 1ine command

» Region specifications from the region command

= Specifications for point, polygon, polyhedron
» User materials created with the mater command

= Contact definitions created with the contact command
= Mask definitions created with the mask command

= Solution commands can be optionally stored using the store parameter of the solution
command

s Term commands can be optionally stored using the store parameter of the term
command

s Global Tcl variables can be stored with fset

» Tcl procedures can be stored using fproc

By default, when loading a TDR file, the changes in the parameter database are read in from
the TDR file and are applied. For information about the TDR format, refer to the Sentaurus™
Data Explorer User Guide.

When saving a TDR file, the simulation coordinate system used is also included in the file and
is used by Sentaurus Visual when opening the file.
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The visualization coordinate system is the same as the simulation coordinate system. To change
the coordinate system, use the math command. For the UCS, use:

math coord.ucs

NOTE Itis recommended to always use the math coord.ucs command.

Saving a Structure for Device Simulation

In general, the main steps to saving a structure appropriate for device simulation are:
1. Define contacts.
2. Remesh the structure with appropriate refinement for device simulation.

3. Save the structure with contacts and with Delaunay weights.

Contacts are defined using the contact command. To define contacts, you can either:
s Use a box where the contact is created at the intersection of a material interface and a box.

» Use a region contact in which a region is specified by giving a point inside the region; then
all boundaries of this region become a contact.

The contact is given a name and, if the command is executed multiple times with the same
contact and the add parameter, the contact will include all parts specified. There are also
options for creating a contact on the outer boundaries and so on (see contact on page 381).

Remeshing the structure is needed to create a mesh that is better suited to device simulation.
Typically, this means discarding process-based refinements, creating a very fine mesh under
the channel, and refining on the p-n junction. A typical sequence of steps is:

= Clear the process mesh:

refinebox clear
line clear

= Reset default settings for adaptive meshing:

pdbSet Grid AdaptiveField Refine.Abs.Error 1.e37
pdbSet Grid AdaptiveField Refine.Rel.Error 1lel0
pdbSet Grid AdaptiveField Refine.Target 100.0

» Set high-quality Delaunay meshes:
pdbSet Grid SnMesh DelaunayType boxmethod
= Set mesh spacing near interfaces:

pdbSet Grid SnMesh min.normal.size <n>
pdbSet Grid SnMesh normal.growth.ratio.2d <n>
pdbSet Grid SnMesh normal.growth.ratio.3d <n>

Sentaurus™ Interconnect User Guide
N-2017.09



2: Working With the Simulator
Saving Structures

= Set which interfaces will have interface refinement:

refinebox interface.materials= {Silicon}

» Specify adaptive refinement:

pdbSet Grid Adaptive 1

» Specify lines if necessary:

line y loc= $Ymin+0.001
line z loc= $Zmin+0.001

» Specify refinement boxes, for example:

refinebox min= <list> max= <list> xrefine= <list> yrefine= <list>
zrefine= <list> ;# gate refinement

refinebox refine.fields= NetActive max.asinhdiff= {NetActive= 1.0} \
refine.min.edge= <list> Silicon ;# adaptive refinement on NetActive

» Ifyou use the IC WorkBench Edit/View Plus—TCAD Sentaurus interface, it may be helpful
to consider using the mask argument of the refinebox command (see Chapter 13 on
page 285 and refinebox on page 591).

To save the structure for device simulation, use the command struct tdr=<c> !Gas. This
command causes a remesh if necessary, stores any contacts that have been defined previously,
and includes fields required for device simulation.

Delaunay weights can be saved in the structure intended for device simulation by setting these
parameters before generating the mesh:

pdbSet Grid SnMesh StoreDelaunayWeight 1
pdbSet Grid Contacts.In.Brep 1

The first parameter StoreDelaunayWeight creates the field variable Delaunay—Voronoi
weight (DelVorWeight) that is used in the weighted box method in Sentaurus Device. The
second parameter Contacts.In.Brep switches on a feature that creates contacts in the
boundary representation (brep) and prevents changes to the mesh that can locally invalidate the
Delaunay weight.

Saving 1D Profiles for Inspect

To store .plx files, use the WriteP1lx command. The command SetPlxList selects the
fields to be stored in the .p1x file. The Set P1xList command is similar to the Set TDRList
command, except that no fields are selected by default. Only the field names specified in
SetPlxList are stored in the .plx file (see SetPlxList on page 619 and WritePIx on
page 681).
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Saving 1D TDR Files From 2D and 3D Simulations, and 2D
TDR Files From 3D Simulations

The command struct also saves a 1D TDR file if the proper cutting coordinates are specified
(see struct on page 643). In two dimensions, only one cutting coordinate is needed (either x or
y; the z-coordinate makes no sense here). In three dimensions, the command saves the
intersection of the planes specified by two cutting coordinates (for example, specifying x and
z will save the y line containing those x- and z-coordinates). In addition to storing the mesh
and data, these files save any contacts that apply at the cut point, so that the file can be loaded
into Sentaurus Device for electrical analysis. This file can be visualized with Sentaurus Visual.

For 3D simulations, the struct command also saves 2D TDR files when one cutting
coordinate is specified.

For example, in a 2D simulation, the following command picks up all the x-coordinates with
y=0.5 and saves them in a 1D TDR file:

struct tdr= filename y= 0.5

In addition, in a 3D simulation, the following command saves the y-coordinates with x=0.2
and z=0.1 as a 1D TDR file:

struct tdr= filename x= 0.2 z= 0.1

The following command saves a 2D cross section of the 3D structure to a 2D TDR file at x=0.2:

struct tdr= filename x= 0.2

The select Command (More 1D Saving Options)

The select command is a versatile command for many operations such as viewing results,
postprocessing, and initializing or changing datasets. The basic command is:

select z=<c>
where <c> is an Alagator expression (see Chapter 16 on page 343). A simple example of an

expression is the name of a data field such as Potential and VTotal. The value of the
expression is stored in the selected field.

This selected field can be viewed with print.data or print.1d, for example, or the
integrated values can be obtained using the 1ayers command. The select command can also
be used to set an existing data field or create a new data field, for example:

select z= 1.0 name= MyDataField ;# create a new data field named MyDataField
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;# and set it to 1.0 (everywhere)

select z= 0.1*Vacancy name= Void store ;# Set Void equal to 0.1l*Vacancy

The datexcodes.ixt File

The datexcodes.txt file is the Synopsys configuration database for materials, doping
species, and other quantities that are used in semiconductor process and device simulations.
Sentaurus Interconnect uses this file in two ways:

= The "floops" property of each field is read in and is used as a conversion factor between
short internal names and proper DATEX names expected by other tools.

s Theunit field is read from the datexcodes . txt file and is used to convert internal units
to those units expected by other tools.

For example, the distributed datexcodes . txt file contains the following field definition:

VacancyConcentration {

label = "total Vacancy concentration"
symbol = "VTotal"

unit = "cm”-3"

factor = 1.000E+12

precision = 4

interpol = arsinh

material = All

alterl = vacancy

alter2 =0

property("floops") = "VTotal"

J

From this definition, Sentaurus Interconnect reads property("floops") to enable
conversion of the internally named field vTotal to VacancyConcentration in the TDR file
and to save VacancyConcentrationin cm .

References

[1] B. B. Welch, Practical Programming in Tcl & Tk, Upper Saddle River, New Jersey:
Prentice Hall PTR, 3rd ed., 2000.
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This chapter discusses the computation of mechanical stress in
Sentaurus Interconnect.

Overview

Mechanical stress has an important role in process modeling. It controls the structural integrity
of the device, the yield from the process depends on stresses, the mobility of charged carriers
is changed by stresses, and leakage currents also are a function of the stress in the system.

In modern process flows, accurate computation of stress is important. However, there is a
continual trend toward designing process flows that produce the right types of stress in the
device. With appropriate stresses, device performance can be enhanced significantly.

Stress computation simulations are performed in the following distinct steps:

1.

Define the equations for mechanics. The equations used in Sentaurus Interconnect define
force equilibrium in the quasistatic regime.

Define the boundary conditions for these equations. For the elliptic equations that arise
from the equations of force equilibrium, boundary conditions are needed on all boundaries.
Sentaurus Interconnect allows Dirichlet or Neumann boundary conditions, provided that
certain criteria are met. The minimum criterion is to constrain the structure sufficiently so
that it has no rigid body modes.

Define material properties. This step defines the relationship between stresses and strains.
Some materials may hold stresses for a given strain without relaxing; these are elastic
materials. Other materials may relax the stresses away; these are viscous or viscoelastic
materials. Sentaurus Interconnect provides viscoelastic constitutive equations for the
computation of mechanical stresses. By setting parameters appropriately, the extreme cases
of a purely viscous material and a purely elastic material can be simulated as well. The
viscoelastic models used in Sentaurus Interconnect provide a choice between the Maxwell
model and the standard linear solid model. The viscosity can depend on the local shear
stresses, which make the viscosity a locally varying quantity and can lead to nonlinear
mechanical behavior. In addition to elastic and viscoelastic materials, there are materials to
model irreversible deformation and temperature-dependent volume change. Sentaurus
Interconnect provides nonlinear material models for incremental plasticity, deformation
plasticity, viscoplasticity and creep, and swelling.
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4. Define the mechanisms that drive the stresses. In Sentaurus Interconnect, this is performed
through intrinsic stresses, thermal mismatch, and densification. All these processes are
additive in the linear elastic regime. In the nonlinear regime, they must be updated from the
available stress history.

Stress is solved in all materials. Parameters describing material behavior, which will be
introduced in this chapter, can be found in the parameter database:

<material> Mechanics

In the following sections, the constitutive equations are discussed in detail. These tensor
equations can be split into two components:

» The dilatational component, which corresponds to the trace of the tensor, describes the
material behavior in the case of a pure volume change.

» The deviatoric component describes an arbitrary deformation but without changing the
volume.

For example, the strain tensor can be decomposed as follows:

, 1
g; = & + 3(28“)517 (D)
k

deviatoric

dilatational

This decomposition will be used in subsequent equations to discuss the constitutive equation
for the dilatational and deviatoric components independently.

Material Models

Sentaurus Interconnect implements the viscous, viscoelastic, and elastic models in a general
manner, where the viscous model and elastic model can be derived from the viscoelastic model.
The viscous and viscoelastic models use shear stress—dependent viscosity. The elastic model
also has anisotropic elasticity where the elastic coefficients depend on the crystal orientation.
The plasticity models describe the material behavior beyond yield, independent of the rate of
loading. The viscoplasticity and creep models provide rate-dependent plastic behavior, while
the swelling material models temperature-dependent volume change.
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Viscoelastic Materials

The viscoelastic material response is characterized by elastic and viscous components. The
combined response depends on how elastic and viscous stresses or strains are coupled.
Sentaurus Interconnect provides two commonly used combinations:

s Maxwell model

s Standard linear solid model

Maxwell Model

The viscoelastic behavior for the Maxwell model is obtained by combining elastic and viscous
responses in series. The stress—strain equations are written in terms of dilatational and
deviatoric components. The equations for the volumetric component of the stress tensor! take
the form:

o, o, .
Sy =3¢
K n/(T o)) '

> On= —3p = 30,
k

2)

where 1, is the bulk viscosity. In addition, the relation of the stress and strain tensor to the
hydrostatic pressure p is shown. The bulk modulus K can be computed from the Poisson ratio
(PoissRatio) and Young’s modulus (YoungsMod) as:

YoungsMod (3)

K =
3(1 -2 - PoissRatio)

The deviatoric component of the stress tensor is described by:
“4)

where 7' is the shear viscosity. The shear modulus G can be computed from the Poisson ratio
and Young’s modulus as:

_ YoungsMod (5)
~ 2(1 + PoissRatio)

1. The subscripts of vectors and tensors hold for the Cartesian coordinates X, y, and z.
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By default, the viscoelastic response is applied to the deviatoric components. The linear elastic
model is used for the pressure—volume response, that is:

G, = KZskk (6)
k

To apply the viscoelastic response to both the deviatoric components and the volumetric
component, use:

pdbSet Mechanics NoBulkRelax 0

The shear viscosity 1’ is a function of the shear stress and the temperature 7', where:

N'(T) = Viscosity0 - exp(_m (7
kgT

Usually, the value of ViscosityW is negative and, therefore, the shear viscosity 1n' decreases

with increasing temperature. The bulk viscosity has a similar Arrhenius expression defined by

the parameters Viscosity0.K and ViscosityW.K. The dependency on the shear stress o,

is discussed in Shear Stress—Dependent Viscosity on page 50.

Standard Linear Solid Model

In the standard linear solid model, the material behavior is modeled by combining the elastic
response in parallel with the Maxwell model-based viscoelastic response:

o, = of’} + civje ®
where G?} is the elastic stress and Gl-vje is the viscoelastic stress. The difference compared to the
Maxwell model allows the total stress to be nonzero even after the viscoelastic stress has
relaxed away:

el
0;i(t—> ) = o )
The dilatational and deviatoric components of the elastic and viscoelastic stresses are written
in the usual form:

v = 3Kbaseev
0'?} = 2Gbase8'ij
(-SVQ Gve
S i = 3 (10)
n,(T0,)
.,ve \ve
% i -,
n'(T.o,)
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where:
» K, and G, are the bulk and shear moduli for the elastic response, respectively.

» K and G are the bulk and shear moduli for the elastic component of the viscoelastic
response, respectively.

= 1, and ' are the bulk and shear viscosities, respectively.

» ¢, and €; are the dilatational and the deviatoric components of mechanical strain,
respectively.
To enable the standard linear solid model, use:

pdbSetSwitch <materials> Mechanics ViscoElasticity.Model SLS-Maxwell
The default value for the above parameter is Maxwel1l for the Maxwell model.

The elastic response for the standard linear solid model is inactive, by default, so that the
material behavior is similar to that of the Maxwell model. The elastic response can be activated
by providing nonzero values for the bulk and shear moduli:

pdbSetDouble <materials> Mechanics BaseBulkModulus <n>
pdbSetDouble <material> Mechanics BaseShearModulus <n>
The material parameters for the viscoelastic response are specified in the same way as for the

Maxwell model. By default, the dilatational component of viscoelastic stress is assumed to be
purely elastic:

o' = 3Ke, (11)

To activate the viscoelastic response for the dilatational component, use:

pdbSet Mechanics NoBulkRelax 0

To visualize elastic and viscoelastic responses, this model provides additional output fields.
Stresses and strains for the elastic response can be viewed with the BaseStressEL and
BaseElasticStrainEL fields, respectively. Creep strains afjr for the viscoelastic response
can be viewed with the CreepStrainEL field:

; Gve G'V
cr v ij

e.. = — + —L |dt 12
Y '[O (21]\/ ZT:J ( )

The solution for viscoelastic stress is time dependent. It also becomes nonlinear when viscosity
is a function of viscoelastic shear stress. Therefore, the Newton method is used to solve for
stresses. At the end of each Newton iteration, a check is made on whether the convergence
criteria have been satisfied. More iterations are performed until all the criteria are satisfied
within the specified tolerance or until the maximum number of iterations is reached. For details
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about convergence criteria and time-stepping for mechanics, see Time-Step Control for
Mechanics on page 338.

Purely Viscous Materials

Oxide and nitride, by default, are treated as viscoelastic materials. However, the viscosity is a
function of temperature (see Eq. 7). With increasing temperature, the viscosity decreases, that
is, the material becomes increasingly more liquid. When the viscosity reaches a very low value,
the first term in Eq. 4 can be neglected:

o, , :
n'(Tji,kc) =28 <0 =2M'E (13)

Eq. 13 describes the deviatoric component of a purely viscous material. The relaxation time
T = M'/G typically gives a good estimate of the behavior of a viscoelastic material. If T is
much greater than the process time, the material is in the elastic regime. The material behaves
viscoelastically if T is in the range of the process time. If T is very small, the material is in the
viscous regime.

Shear Stress—Dependent Viscosity

For viscous and viscoelastic materials, the viscosity may depend on the temperature and the
shear stress o,. The temperature dependency is described by Eq. 7. The dependency on the
shear stress is given by:

GS/GCI'it
nee,T) = n(T)-m (1

The shear stress o, is computed from the local stress distribution based on the second invariant
of the deviatoric component of the stress tensor:

E -
o, = ZZ k ij ij (15)
J

The viscosity breakdown value 6, can be determined by:

2kgT
Ouit = S (16)
crit
where:
Verid(T) = Verit0 - eXp(-VCrltW) .
kgT
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By default, oxide and nitride are treated as viscoelastic materials with shear stress—dependent
viscosity. The values for Verito and Veritw also are set in the parameter database:

pdbSetDouble <materials> Mechanics Vcrit0
pdbSetDouble <material> Mechanics VcritW

Purely Elastic Materials

If the viscosity in Eq. 4, p. 47 is chosen high enough, the second term on the left can be
neglected and the equation reads:
Ok

+ =28 &) =26g, (18)

This equation describes the deviatoric component of a purely elastic material. By default,
silicon and polycrystalline silicon are treated as purely elastic materials. To achieve this, the
viscosity of these materials is set to 1x10" poise .

NOTE K and G are the primary parameters describing elastic materials, and
not Young’s modulus and the Poisson ratio. When changing material
properties with the pdb command, only a change to the primary
parameters affects the simulation. To obtain Young’s modulus and the
Poisson ratio, use the commands KG2E on page 477 and KG2nu on
page 478, respectively.

NOTE When material data is given in terms of Young’s modulus and the
Poisson ratio, use the commands Enu2G on page 411 and Enu2K on
page 412 to convert them to the shear modulus and the bulk modulus,
respectively.

Anisotropic Elastic Materials

The stress and strain relations for anisotropic elastic materials can be described using:

51 = Gy, (19)

where 0; and €; are the components of the engineering stress and strain, respectively, and C;;
is the component of the stiffness matrix. The engineering stress ¢; (i=1, ..., 6) corresponds to
the stress-tensor components ©,,, Gy, G,,, Oy, Oy,, Oy,, and the engineering strain g;

vy’ xy» Oyz
(j=1, ..., 6) corresponds to the strain-tensor components €,,, €, £,,, 2€,, 2€,,, 2€,, .

yy? xy> “Cyz
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NOTE The engineering shear-strain components differ from the shear-strain
tensor components by a factor of 2.

Cubic Crystal Anisotropy

The mechanical responses of a crystalline solid vary along various crystal orientations. For a
cubic crystal, the axes of reference are chosen to be parallel to the crystal axes. In a coordinate
system with axes aligned along the crystal axes, the symmetric stiffness matrix C has the
following nonzero components: C;; = C,; = Cs3, C;p = Cy3 = Ci3, Cyy = Cs5 = Cgg.

All other components are zeros. The anisotropic stress and strain relation is completely defined
when three independent modulus parameters C11, C12, and C44 are specified.

The degree of anisotropy for a given material can be measured by the departure from unity of
theratio A = 2 Cy/(C,, — C},) . The anisotropic model reduces to the isotropic model if the
ratio A is equal to 1. When the simulation coordinate axes do not coincide with the crystal axes,
the stiffness matrix C must be transformed accordingly. For this, note that C is actually a
rank-4 tensor.

By default, the anisotropic elasticity model is switched off. The following command switches
on the model:

pdbSet Silicon Mechanics Anisotropic 1

The values of these three modulus parameters with respect to the cubic crystal axis can be
defined using the following commands, which also show the default values for the crystalline
silicon:

pdbSet Silicon Mechanics C11 16.57E11l
pdbSet Silicon Mechanics C12 6.39E11l
pdbSet Silicon Mechanics C44 7.96E1l

The unit for these default values is dyn/cm2 .

This model depends on the wafer.orient and slice.angle parameters specified in the
init command.

Hexagonal Crystal Anisotropy

The mechanical responses of a crystalline solid vary along various crystal orientations.
Hexagonal close-packed crystals contain a plane of isotropy. In a coordinate system with axes
aligned along the crystal axes, the symmetric stiffness matrix C has the following nonzero
components: Cy; = Cp,, Cs3, Cpy, Cp3 = Cp3, Cyy = Css5, Cgg = (€1, - C1p)/2.
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All other components are zeros. The anisotropic stress and strain relation is completely defined
when five independent modulus parameters C11, C12, C13, C33, and C44 are specified.

When the simulation coordinate axes do not coincide with the crystal axes, the stiffness matrix
C must be transformed accordingly. The transformation depends on the crystal orientation
information specified in the init command and the mater command.

The values of these five modulus parameters with respect to the crystal axis can be defined
using the following commands, which also show the default values for crystalline GaN:

pdbSet <material> Mechanics C11 39.0Ell
pdbSet <material> Mechanics Cl12 14.5E1l1l
pdbSet <material> Mechanics C13 10.6E1ll
pdbSet <material> Mechanics C33 39.8Ell
pdbSet <material> Mechanics C44 10.5E1l1l

The unit for these default values is dyn/cmz.
The hexagonal anisotropic elasticity model is applied to certain wurtzite III-V nitride

materials. The following command switches on the model:

pdbSet <material> Mechanics Anisotropic 1

The material must be set to crystalline with hexagonal lattice type, for example:

pdbSetBoolean <materials> Amorphous 0
pdbSetString <materials> LatticeType Hexagonal

Orthotropic Model

Orthotropic materials have three planes of symmetry. In a coordinate system with axes aligned
along the symmetry planes, the symmetric stiffness matrix C has the following nonzero
components: C,;, Cyy, Cs3, Cuy, Css, Co, Ci1n = Cyy, Ci3 = Cs3p, Cp3 = Cs,. The symmetry
planes of the model coincide with the simulation coordinate system, and the axes 1, 2, and 3
become axes X, Y, and Z in the simulation coordinate system, respectively.

Orthotropic material properties can be described by specifying nine independent parameters,
namely, the Young’s moduli in the symmetry planes (E,, E,, E.), the directional shear moduli

G,,, G, G,,), and the directional Poisson ratios ( V,,, V.., V. ). The other directional Poisson
ratios are calculated from:
vV
o 2
B=% (20)
where i,j = x,y, z.
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The stiffness matrix components are calculated from the specified material properties as:

Cc,=E(0 —vyzvzy)xy
Cyp = Ey(l _vle)zx) Xy
Cy3 = E[(1 —nyDyX)XY

Cip = Gy = E(vy, 40,0 )XY @1
Ci3=0C5 = Ez(uxz+uxyuyz)xy

Cyy = C3y = Ey(Uzy+szny)Xy

-1
= (1- VD =0y 0 =0, 0, = Z(Dyx‘)xz”zy))

=<2
|

Cyy = Gyz
Css = Gy, (22)
C66 - Yy

By default, the orthotropic model is switched off. It is switched on using the command:

pdbSet <material> Mechanics Orthotropic 1

The material properties can be specified by the command:

pdbSetDouble <material> Mechanics <material parameter> <n>

specifically:

pdbSetDouble <material> Mechanics YoungsModulusX <n>
pdbSetDouble <material> Mechanics YoungsModulusY <n>
pdbSetDouble <material> Mechanics YoungsModulusZ <n>
pdbSetDouble <material> Mechanics PoissonRatioXY <n>
pdbSetDouble <material> Mechanics PoissonRatioXZ <n>
pdbSetDouble <material> Mechanics PoissonRatioYZ <n>
pdbSetDouble <material> Mechanics ShearModulusXY <n>
pdbSetDouble <material> Mechanics ShearModulusXZ <n>
pdbSetDouble <material> Mechanics ShearModulusYZ <n>

The units for Young’s modulus and the shear modulus are dyn/cmz.
Orthotropic thermal expansion also is considered in this material model, and different

coefficients of thermal expansion can be specified along the three symmetry planes:

pdbSetDouble <material> Mechanics ThExpCoeffX <n>
pdbSetDouble <material> Mechanics ThExpCoeffY <n>
pdbSetDouble <materials> Mechanics ThExpCoeffZ <n>

54 Sentaurus™ Interconnect User Guide
N-2017.09



3: Computing Mechanical Stress
Material Models

Temperature-dependent material properties can be specified for all the material parameters
specified above. The variation of a property & can be specified as:

E(T) = &ref +&(T- T.p) (23)
where the reference value is the material parameter value specified in the command file.

The values can be specified as:

pdbSet <material> Mechanics <material parameter>Rate <n>

For example:

pdbSetDouble FR4 Mechanics ThExpCoeffXRate 0

These orthotropic parameter entries exist for silicon, and the shorthand pdbSet command can
be used. The default values are set to replicate isotropic elastic behavior.

NOTE The older parameters using the 1, 2, 3 indices are deprecated and are
replaced with the new parameters using the X, Y, Z indices.

NOTE Anisotropic elastic models and plastic or viscoplastic models must not
be switched on simultaneously for the same material.

Plastic Materials

Materials such as metals show linear elastic behavior at lower stresses but undergo permanent
deformation at higher stresses. At low temperatures, permanent deformation in these materials
is not sensitive to the rate of loading. Such material behavior is defined as plastic or elastic-
plastic. Depending on the type of loading, plastic deformations may be computed using
incremental plasticity or deformation plasticity.

To switch on the plastic material model, use the command:

pdbSet <material> Mechanics IsPlastic <n>

Incremental Plasticity

Plastic material behavior under nonmonotonic loading is modeled using incremental
formulation.

Sentaurus™ Interconnect User Guide 55
N-2017.09



3: Computing Mechanical Stress
Material Models

Incremental plasticity uses the von Mises yield criterion with associative flow and bilinear
hardening. The von Mises yield criterion for isotropic solid materials takes the form:

F(G‘,'ja dijp o) = A/(G‘,'j_q,'j)(d,‘j_q,‘j)_ Y(a) = 0 (24)

where:
= g, is the back stress.
= O is an isotropic hardening variable.

= Y(0) is a function describing the change of yield surface with progressive yielding. This
function can be set to linear or exponential with:

pdbSetSwitch <materials> Mechanics Incremental.Plasticity.Yield.Model
<Linear | Exponentials

. . 2 . . .
The linear relation takes the form Y(a) = \L:(Gy + H;,0.) where G, is the yield stress in
uniaxial tension, and Hy, is the isotropic Hardening modulus. ¢, and H,, can be set
respectively using the commands:

pdbSetDouble <materials Mechanics Incremental.Plasticity.SigmaY <n>
pdbSetDouble <materials Mechanics Incremental.Plasticity.Hiso <n>

The exponential relation takes the form Y(a) = f (0, + Ro(1 — exp(=bi;,))) where
R;,, and b, are parameters for nonlinear (exponential) isotropic hardening. To set these
parameters, use the commands:

pdbSetDouble <materials Mechanics Incremental.Plasticity.Riso <n>
pdbSetDouble <materials Mechanics Incremental.Plasticity.Biso <n>

Under a small strain assumption, the strains (and strain rates) are decomposed additively:

g = €eel (25)

ij
where 82» are the elastic strains, and ef’j are the plastic strains.
For incremental plasticity, the plastic strains are determined by the plastic flow rule:

& = 492 (26)

P 'Y_
Y J0; ’
where 7> 0 is the slip rate, and Q is the plastic potential. Plastic flow is assumed to be volume

preserving, so that plastic strain is purely deviatoric:

sf’jBU =0 = s'g = 85 27
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For associative plastic flow, the plastic potential Q is set equal to the yield function F. The
evolution of the isotropic hardening variable and the back-stress variable is given by:

o= = %

2. (0',-,-—(1,-,-)

3 (28)
éi' = —Y[H in _A/:H inqij
A SO =) (S = ay) 2 NbaTy

where H,;, is the linear kin%matic hardening modulus, Hy;,, is the parameter for nonlinear
kinematic hardening, and e is the equivalent plastic strain rate. The Einstein summation
convention is used to define the tensor product in this equation.

To set the kinematic hardening parameters, use the commands:

pdbSetDouble <material> Mechanics Incremental.Plasticity.Hkin <n>
pdbSetDouble <material> Mechanics Incremental.Plasticity.HNLkin <n>

For linear isotropic hardening, the hardening modulus is interpreted as the slope of the stress

versus the plastic strain curve (as obtained from uniaxial tension test) H; = Ll

de’
It differs from the elastic-plastic tangent modulus, which is defined as the slope of the stress
versus total strain curve E? = ‘2—:.
To switch on the incremental plasticity model, use:

pdbSet <material> Mechanics Plasticity.Model Incremental

The rate equations are discretized using the backward Euler scheme and then are solved using
a radial return mapping algorithm (see [1] for more details).

The nonlinear nature of the plasticity model requires Newton iterations to achieve the
equilibrium state for each loading step. At the end of each iteration, a check on the satisfaction
of convergence criteria is made. More Newton iterations are performed until all the
convergence criteria are satisfied within the specified tolerance or until the maximum number
of iterations is reached. See Time-Step Control for Mechanics on page 338 for details on
convergence criteria and time-stepping for mechanics.

NOTE To define the plastic model, use nonzero values for the isotropic or the
kinematic hardening modulus along with yield stress. In the absence of
hardening, the numeric simulation of plastic deformation may become
unstable.
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NOTE The PDB parameters Hardening.Modulus.Isotropic,
FirstYield, and Hardening.Modulus.Kinematic are deprecated
and are replaced by Incremental.Plasticity.Hiso,
Incremental.Plasticity.Sigmay, and
Incremental.Plasticity.Hkin, respectively.

Deformation Plasticity

Plastic materials that do not have well-defined yield stress can be modeled using deformation
plasticity. This model is based on the Ramberg—Osgood formula [2][3], which is only valid for
monotonic loading. It is used mostly for plastic deformation around crack tips since it is well
suited to the J-integral calculation.

For one dimension, an additive decomposition of strains under a small strain assumption is
given as:

e=¢+¢’ = %+a(<iy)(g)" (29)

where o0 and n are material parameters, G is the stress in one dimension, € is the total strain
in one dimension, and E is Young’s modulus.

Extending the formula to three dimensions, the strain components can be expressed as:

elastic plastic
ST n_,
e..=¢€C +¢ebP = G—U + GkkSU + §0(($) G—eq 2 (30)
Y veoouo 2G 9K 2 \E 0,) ¢

3 . .
where ¢* = IEG'UG'” is the equivalent stress.

The plastic flow is assumed to be associative and is governed by the von Mises yield criterion.

Under monotonic loading, the total plastic strain can be written as:

3 pG“
85 = ze G—elé (31)

6\ (" . . : .
where e’ = OC(E}) (%q) is the total equivalent plastic strain.
y

Inverting the plastic strain expression gives:

o = o) )" (32)

O(Gy
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with m = }l defining the work hardening exponent.

To set the material parameters, use the commands:

pdbSetDouble <materials> Mechanics Deformation.Plasticity.sigmay <n>
pdbSetDouble <materials> Mechanics Deformation.Plasticity.n <n»>
pdbSetDouble <materials> Mechanics Deformation.Plasticity.alpha <n>

To switch on the deformation plasticity model, use:

pdbSet <material> Mechanics Plasticity.Model Deformation

The deformation plasticity equations do not require any integration due to total stresses and
strains. However, the nonlinear expressions require Newton iterations to achieve the
equilibrium state for each loading step. At the end of each iteration, a check on the satisfaction
of convergence criteria is made. More Newton iterations are performed until all the
convergence criteria are satisfied within the specified tolerance or until the maximum number
of iterations is reached. See Time-Step Control for Mechanics on page 338 for details on
convergence criteria and time-stepping for mechanics.

NOTE Deformation plasticity must be used only with monotonic loading since
the equations are not valid for unloading. This model must be used if the
J-integral must be calculated around a crack tip with plastic strains.

Viscoplastic Materials

Materials, such as metals at high temperatures, exhibit rate-dependent plasticity also known as
viscoplasticity or creep. There are different ways to model such behavior:

» Anand model

= Power law creep

Anand Model

The Anand model [4][5] is used for rate-dependent plasticity that combines creep and plastic
deformation.

Assuming small strains, the strain rates and strains can be decomposed into elastic and
viscoplastic components in an additive manner:

. .e . Vp

€ = &;+¢&;

] ] (33)

€
& = &;tey

|
™
—+
™
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The elastic strains are evaluated using Hooke’s law, while the Anand model is used to evaluate
the viscoplastic component. The Anand model assumes that plastic deformation occurs at all
values of strain, so instead of a yield function, a constitutive equation is used to relate stresses
to viscoplastic strains.

The flow rule for evolution of viscoplastic strains (volume preserving) is assumed to be of the
familiar form:

VP 3"Vp6‘ij_ 0 - -
ey = BT ol= o0, (34)

The equivalent viscoplastic strain rate at constant temperature is given by a constitutive
equation:

e’ = fda'll, s) = Aexp(—]%,) [sinh(ﬁ@ﬂl/m (35)

where s is the deformation resistance. It is defined in terms of an isotropic hardening function

as:
(1 S) a
S*

The saturation value of deformation resistance at a given temperature and strain rate is
expressed as:

§ = his)ye = hy

sgn(l - ;%) évp; a1 (36)

n

= s{%exp@%}} (37)

In the above formulation:

= A is a pre-exponential factor (1/s).

= Q is the activation energy in eV.

= kg is the Boltzmann constant (8.617383e-5 eV/K).

= T isthe absolute temperature in kelvin.

s & is the stress multiplier (unitless).

= m is the strain rate sensitivity (unitless).

= h, is the constant of athermal hardening or softening in dyn/cm2 .

= a is the exponent of athermal hardening or softening (unitless).

» 5 is the coefficient for the saturation value of deformation resistance in dyn/cm2 .

= 7 is the exponent for the saturation value of deformation resistance (unitless).
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Values for the material parameters A, Q, &, m, h, a, s, n and the initial value for deformation
resistance s, are obtained by fitting experimental data for stress—strain (obtained from tension
or compression tests conducted at various temperatures and strain rates) to the above equations.
For details on how to obtain such data, refer to the literature [4][6][7][8].

To set these parameters, use the commands:

pdbSetDouble <material> Mechanics Viscoplasticity.A <n>
pdbSetDouble <material> Mechanics Viscoplasticity.Q <n>
pdbSetDouble <material> Mechanics Viscoplasticity.Xi <n>
pdbSetDouble <material> Mechanics Viscoplasticity.m <n>
pdbSetDouble <material> Mechanics Viscoplasticity.h0 <n>
pdbSetDouble <material> Mechanics Viscoplasticity.a <n>
pdbSetDouble <materials> Mechanics Viscoplasticity.stilde <n>
pdbSetDouble <material> Mechanics Viscoplasticity.n <n>
pdbSetDouble <material> Mechanics Viscoplasticity.s0 <n>

NOTE For other materials, use the long form of the pdb commands to set
parameter values.

The material Solder in the PDB is used to model viscoplastic behavior. The default values for
the above parameters for Solder material are based on 96.5Sn3.5Ag solder alloy as reported
in [6].

To solve the above nonlinear equations, the rate terms are discretized using the backward Euler
method, and the resulting algebraic equations are evaluated locally at every integration point
using the Newton—Raphson iterative scheme.

To switch on the viscoplastic material model, use the command:

pdbSet <material> Mechanics IsViscoPlastic <n>

This flag must be switched on during the simulation if viscoplastic deformation exists. The
nonlinear nature of the viscoplasticity model also requires Newton iterations to achieve
equilibrium of mechanics equations at each loading step. At the end of each iteration,
convergence criteria are checked. More iterations are performed until all the convergence
criteria are satisfied within the specified tolerance or until the maximum number of iterations
is reached. See Time-Step Control for Mechanics on page 338 for details on convergence
criteria and time-stepping for mechanics.

NOTE To avoid convergence problems, use small time steps at the beginning
of the analysis. You can increase the number of time steps later, during
the analysis, if it does not adversely affect the solution.
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Power Law Creep

Power law creep models primary (transient) and secondary (steady-state) creep behavior in
metals at high temperatures. Depending on the microstructural processes being modeled,
power law creep may be formulated as either Bailey—Norton creep or Mukherjee—Bird—Dorn
creep.

To switch on the creep material model, use the command:

pdbSet <material> Mechanics IsCreep <n>
Bailey—Norton Creep

Bailey—Norton creep [9] assumes creep strain to be of the following form:

& - Aexp(—]%) &"mi" Y (38)

where, for multiaxial loading:

« Cr 2 «Cr.cr . .
= £ = /§ ;i€ 1s the equivalent creep strain rate (1/s).

mn

= A is a pre-exponential factor in (dyn/cm’)”" s
= ( isthe activation energy in eV.

= kg is the Boltzmann constant (8.617383e-5 eV/K).

= T is the absolute temperature in kelvin.

= O = ZG’UG' ;; 1s the equivalent stress or the von Mises stress in dyn/cm2 .
s 1 is the time (different from physical time) in s.

= n and m are exponents (unitless).

The above form is referred to as a time hardening form. A more commonly used form called
the strain hardening form is obtained by eliminating the time variable:

1

¢ = m(Aexp(—ngT) (_Sn(ecr)(m_ 1));l 39)

The material parameters A, O, n, and m are obtained by fitting experimental data. To select
this creep model and to set these parameters, use the commands:

pdbSet <material> Mechanics Creep.Model PowerLawBN
pdbSet <material> Mechanics Creep.A <n>
pdbSet <material> Mechanics Creep.Q <n>
pdbSet <material> Mechanics Creep.n <n>
pdbSet <material> Mechanics Creep.m <n>
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NOTE For materials other than Solder, use the long form of these commands
to set parameter values.

The default values for the above parameters have been added to the PDB to the Solder
material based on the 96.5Sn3.5Ag solder alloy as reported in [10].

Mukherjee—Bird—-Dorn Creep

Mukherjee—Bird—Dorn creep [11][12] assumes creep strain to be of the following form:
cr_ AGb 0 \(b\P(c\"
€ = };fDoe"P(—g) e (40)

where, for multiaxial loading:

. [2.0r.cr . .
. & = 3 Zre,c,r is the equivalent creep strain rate (1/s).

s A is a dimensionless constant (unitless).

= D, is the frequency factor for diffusion in cm’/s .
= G is the shear modulus in dyn/cm2 .

= kg is the Boltzmann constant (8.617383e-5 eV/K).
= Q is the activation energy in eV.

= T is the absolute temperature in kelvin.

= b is the magnitude of the Burgers vector in cm.

» d is the grain size/diameter in cm.
— B . . . .
= O = §G ;j0';; 1s the equivalent stress or the von Mises stress in dyn/cm2 .

]
= n and p are exponents (unitless).

The material parameters A, D, b, Q, n,and p are obtained by fitting experimental data. To
select this creep model and to set these parameters, use the commands:

pdbSetBoolean <materials> Mechanics Creep.Model PowerLawMBD
pdbSetDouble <materials> Mechanics Creep.A <n>

pdbSetDouble <materials> Mechanics Creep.D0 <n>
pdbSetDouble <materials> burgVectMod <n>

pdbSetDouble <materials> Mechanics Creep.Q <n>

pdbSetDouble <materials> Mechanics Creep.n <n>

pdbSetDouble <materials> Mechanics Creep.p <n>

Sentaurus™ Interconnect User Guide 63
N-2017.09



3: Computing Mechanical Stress
Material Models

The creep model uses the current grain size when the grain growth model is active (see Grain
Growth Model on page 163). The grain size for the grain growth model is set using the
command:

pdbSetDouble <materials> GrainSize <n>

When the grain growth model is not active, the grain size must be specified using GSize in the
select command.

Integrating Creep Equations
Under a small strain assumption, strains (and strain rates) can be decomposed additively as:
g, = efj+sf-’j+efjr 41)

with creep strains being distinct from plastic strains.

Creep flow is assumed to be volume preserving (i—:fjrﬁij = () and is governed by:

5 = 32 (42)

When incremental plasticity is also active, the creep flow rule is modified to account for

hardening:

or 3.cr G',-j—q,-j

& =3¢ (T) (43)
where:
= O = §(cs'ij—q,:,-)((i’ij— q;;) is the equivalent stress.

2
= g;; is the back stress for kinematic hardening.

= Plastic flow equations are solved simultaneously with creep flow.

To solve the creep equations, the rate terms are discretized using the backward Euler method,
and the resulting algebraic equations are evaluated locally at every integration point using the
Newton—Raphson iterative scheme.

The nonlinear nature of the creep model also requires global Newton iterations to achieve
equilibrium of the mechanics equations at each loading step. At the end of each iteration,
convergence criteria are checked. More iterations are performed until all the convergence
criteria are satisfied within the specified tolerance or until the maximum number of iterations
is reached. See Time-Step Control for Mechanics on page 338 for details on convergence
criteria and time-stepping for mechanics.
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NOTE To avoid convergence problems, use small time steps at the beginning
of the analysis. You can increase the number of time steps later, during
the analysis, if it does not adversely affect the solution.

Swelling

Swelling refers to volumetric expansion of material. Swelling material behavior is defined by
specifying strain rates at various temperatures that are interpolated linearly. To switch on the
model, use the command:

pdbSetBoolean <materials> Mechanics IsSwelling <n>

The swelling strain rate data is specified with a double array:

pdbSetArray <material> Mechanics SwellingStrainRate
Temperature { <temp> {<SSR1> <SSR2> <SSR3>}
<temp> {<SSR1> <SSR2> <SSR3>} ... }

where <temp> is the temperature in degree Celsius, and <SSR1>, <SSR2>, and <SSR3> are
. . . . . . -1
strain rates in the x-, y-, and z-direction, respectively, in s .

Strain rates can be the same (isotropic) or different (anisotropic) in each of the three directions.
For cyclic temperature loading, strain rate data must be given for loading (temperature
increment) as well as unloading (temperature decrement). For example:

pdbSetArray Mold Mechanics SwellingStrainRate Temperature {
27 {0.0 0.0 0.0}
77 {0.001 0.001 0.001}
127 {0.002 0.002 0.002}
80 {0.0012 0.0012 0.0012}
25 {0.0 0.0 0.0}

If strain rate data is not given for unloading, loading data is used for increasing as well as
decreasing temperatures.
Since strains are assumed to be small, swelling strain rates are added to other strain rates:

. . < SW

S,/ = S,’j + S, (44)
and are integrated over time to give total strains:

€y = Ejtey “45)

swW - SW . .

where €; = €&; = 0 fori#j.
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For a given material, only one set of strain rate data can be specified for a solve step. If
necessary, different strain rate data may be specified for the same material in a subsequent solve
step.

Temperature-Dependent Mechanical Properties

The mechanical properties of materials are different at high temperature from those at room
temperature. The elastic modulus of typical materials decreases as temperature rises. Some
materials show nonnegligible changes of mechanical properties at different temperatures.

The temperature dependency can be applied to:

= The bulk modulus and the shear modulus for isotropic materials.

« C,,Cy,,and C, for cubic anisotropic elastic materials.

= C,, Cy, C3, Cs3,and C4, for hexagonal anisotropic elastic materials.

» The coefficient of thermal expansion for isotropic, cubic anisotropic, and hexagonal

anisotropic elastic materials.

Table 4 Temperature-dependent mechanical parameters

Material model PDB parameters
Isotropic elasticity BulkModulus, ShearModulus, ThExpCoeff
Cubic anisotropic elasticity C11, Cl12, C44, ThExpCoeff

Hexagonal anisotropic elasticity |C11, Cl12, C13, C33, C44, ThExpCoeffl, ThExpCoeff2, ThExpCoeff3

Other Refer to the corresponding sections for related parameters and syntax

The temperature dependency for the above-listed mechanical properties can be defined
separately. The available options are:

» The linear dependency is defined with the parameter <parameters.T1, for example:

pdbSet <material> Mechanics BulkModulus.T1l <n>

= Then, the parameter is calculated using P(7T) = P+ P.T1(T —26.85), where the unit of
temperature is degree Celsius.

= The piecewise linear dependency can be specified with:

pdbSetDoubleArray SiliconGermanium Mechanics ShearModulus.TTable
{<T1> <v1> ... <Tn> <vn>}

The unit of temperature is degree Celsius. The linear dependency defined by
<parameters>.T1 is ignored.
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The temperature dependency can be switched off with:
pdbSet Mechanics Parameter.Interpolation 0
NOTE Do not mix new syntax with old syntax (see Plane Stress Analysis on

page 67). Some of the old syntax might exist in the Advanced
Calibration script.

Temperature dependency of yield stress for incremental plasticity (see Incremental Plasticity
on page 55) can be modeled in two ways: linear or exponential.

Linear dependency of yield stress on temperature is modeled as:
T
o, = oof1-7) (46)

where G, is the yield stress at zero absolute temperature (7 = 0), and T, is the reference
absolute temperature. These variables are specified, respectively, by the commands:

pdbSetDouble <materials Mechanics Incremental.Plasticity.SigmaY <n>
pdbSetDouble <materials Mechanics Incremental.Plasticity.RefTemp <n>

Exponential dependency on temperature is modeled through an Arrhenius expression. The
prefactor and exponent of the Arrhenius expression are specified, respectively, by the following
commands:

pdbSetDouble <materials> Mechanics Incremental.Plasticity.SigmaY <n>
pdbSetDouble <materials> Mechanics Incremental.Plasticity.ActEnergy <n>

NOTE The linear and exponential models are mutually exclusive.

NOTE The PDB parameter FirstYieldw is deprecated and is replaced by
Incremental.Plasticity.ActEnergy.

Plane Stress Analysis

In 2D problems, the elastic models implemented in Sentaurus Interconnect follow the plane
strain formulation by default. Under the plane strain assumption:

SZZ = O’ GZZ;/:O (47)

While this is good for structures where the strain in the third direction is very small compared
to the cross section, it would give inaccurate results for thin structures.
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Thin plate-like structures where one dimension is very small compared to the other two can be
modeled under the plane stress assumption:

e, #0;0,=0 (43)
The strain €., is obtained as a function of other strains, for example, for purely elastic
structures:

€= —v(sxx+£y),) (49)

2z

The plane stress model can be switched on for a particular region using:
pdbSetBoolean <material> Mechanics PlaneStress 1
NOTE You must switch on the plane stress model in all regions. Combining

plane stress and plane strain formulations within a structure by
switching on plane stress in only a few regions is not advisable.

Equations: Global Equilibrium Condition

The equations for mechanics in Sentaurus Interconnect are the quasistatic equations of force
equilibrium.

The strain rate tensor is related to the symmetric component of the velocity gradient and is
given by:

L 19y Oy
Ejk = z(a—x]{"'a—xj) (50)

Strain is then related to stresses through any of the models defined in Material Models on
page 46. For all models, the global equilibrium condition is given by:

E)ij(v) _

> =0 (51)
k

The above equations are solved using the finite-element method. The solution is a vector
representing the velocity components at each node. These velocities are used to compute the
strain and stresses. The stresses and the boundary conditions determine the mechanical state of
the system.
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NOTE Stress and strain are derivatives of velocity. They are, therefore,
computed at one order of accuracy lower than the solution variable. This
also means that they are discontinuous across the elements. When
visualized, the stress values may appear poorly converged even if the
linear solver has converged.

In addition, the quasistatic mechanics equations are elliptic in nature and, therefore, are prone
to high levels of shape dependency. This is most frequently seen at